# Table of Contents

1. **Introduction / About This Guide** ................................................................. 9

   About This Guide ............................................................................................... 9
   
   *Quick Start Guide* .......................................................................................... 9

   To Learn More about Smartware Pangaea ..................................................... 9

   To Contact Us .................................................................................................... 9

2. **Installing and Licensing Pangaea** ............................................................... 11

   Workstation System Requirements ................................................................. 11

   Before You Install Smartware Pangaea .......................................................... 11

   *Install Microsoft .NET Framework (Version 4.0)* ......................................... 11

   Installing Smartware Pangaea ......................................................................... 12

   *Automatic Updates* ....................................................................................... 12

   Registering Smartware Pangaea ...................................................................... 12

   *Licensing a New Computer* ......................................................................... 13

   *Offline Licensing (when no Internet connection is available)* .................... 15

   *Updating a License* ....................................................................................... 16

   *Moving a License to another Computer* ....................................................... 17

   *Changing the Registered User on a Workstation* ......................................... 17

3. **Installing and Configuring Microsoft SQL Server** ..................................... 19

   What is SQL Server? ....................................................................................... 19

   SQL Server Requirements ........................................................................... 20

   *Which Version of SQL Server?* .................................................................. 20

   *Which Edition of SQL Server?* .................................................................. 20

   *Where Should SQL Server Be Installed?* .................................................... 20

   *What Does Smartware Pangaea Need from SQL Server?* ......................... 21

   *What If SQL Server is Already Installed?* ................................................... 21

   Installing SQL Server .................................................................................... 21

   *Installing Microsoft SQL Server (Full Edition)* ........................................... 22

   *Installing Microsoft SQL Server Express Edition* ....................................... 22

   Configuring SQL Server for Remote Access ................................................ 22

   *Enable SQL Server Browser Service* ......................................................... 23

   *Enable TCP/IP* ............................................................................................. 27

   *Connecting to the SQL Server using SQL Server Management Studio* ..... 28

   *Mixed Mode Authentication* ....................................................................... 29

   *Allow Remote Connections to the SQL Server* .......................................... 31

   *Restarting the SQL Server* .......................................................................... 33

   *Opening up the Firewall* ............................................................................ 34

4. **Overview of Pangaea** .................................................................................. 35

   The Pangaea User Interface ........................................................................... 35

   Pangaea Objects .............................................................................................. 36

   *Sites* ............................................................................................................... 36

   *The Message Log* ......................................................................................... 37

   *Data Collectors* ............................................................................................ 37

   *Reports* ......................................................................................................... 38

   *Dashboards* .................................................................................................. 38

   *Storyboards* ................................................................................................. 39
10. REPORTS ................................................................................................................. 89

Types of Reports ............................................................................................................. 89
  Trend Reports ................................................................................................................. 89
  Schedule Reports ......................................................................................................... 91
  Formatted Field Reports ............................................................................................. 92
Creating a New Report .................................................................................................... 93
Report Properties ............................................................................................................ 95
  Date Range .................................................................................................................... 96
  Charting Options .......................................................................................................... 96
  Report Style .................................................................................................................. 97
  Minimum Timestamp Difference .................................................................................. 97
  Add rows for each change of Boolean Values .............................................................. 98
Report Tabs ...................................................................................................................... 99
Report Columns ............................................................................................................... 100
  Selecting a Data Collector and Adding Points as Columns ............................................ 100
  Column Properties ........................................................................................................ 102
  Viewing and Editing Point Information and Values ....................................................... 103
Creating Tabs Automatically from Data Collector Folders ............................................. 103
  Add Folder Options ....................................................................................................... 105
  Tab Naming .................................................................................................................. 105
  Column Naming ........................................................................................................... 106
Running the Report ......................................................................................................... 106
  The Report Timestamp Algorithm ............................................................................... 107
Scheduling and Delivering the Report .......................................................................... 109
  Scheduling a Report ..................................................................................................... 109
  Setting the Delivery Options ....................................................................................... 110
  Emailing the Report ..................................................................................................... 111
  Saving the Report to a Local or Network Folder ......................................................... 112
  Uploading the Report to an FTP Site ........................................................................... 112

11. ADVANCED REPORTING TOPICS .......................................................................... 115

Schedule Reports ........................................................................................................... 115
  Creating a Schedule Report ......................................................................................... 116
Formatted Field Reports .............................................................................................. 118
  Creating a Formatted Field Report .............................................................................. 119
  Field Aggregations ....................................................................................................... 120
  Changing the Point Assigned to One or More Fields .................................................. 121
Calculated Columns and Fields ..................................................................................... 121
Exception Reports .......................................................................................................... 123
  Creating an Exception Report ...................................................................................... 124
Aggregate Report Tabs .................................................................................................... 126
  Creating an Aggregate Report Tab .............................................................................. 126
  Specifying Aggregate Functions ................................................................................ 127
Using Excel Templates .................................................................................................... 128
  Creating a Custom Excel Template .............................................................................. 130
  Selecting a Template for a Report .............................................................................. 131
  Editing a Report Template .......................................................................................... 133
# 12. Task Scheduling

- Where to Install and Run the Task Scheduler .......................................................... 137
- Setting Up the Task Scheduler Windows Service ...................................................... 138
  - Allowing Remote Access to the Task Scheduler Service ...................................... 140
- Scheduling Tasks ........................................................................................................ 141
  - Schedule Types ....................................................................................................... 142
- The Task Scheduler Control Panel ........................................................................... 144

# 13. Dashboards

- Creating a new Web Dashboard .................................................................................. 149
- User Interface ............................................................................................................ 150
- Widgets ....................................................................................................................... 152
- Adding Widgets .......................................................................................................... 153
- Connecting Widgets to Point Values ......................................................................... 154
- Editing the Dashboard in the Web Browser ............................................................... 156
- Context Menu ............................................................................................................ 157
- Dashboard Options ..................................................................................................... 159
- Dashboard Templates ................................................................................................. 161
- Dashboard Publishing ................................................................................................. 163
- Notes ......................................................................................................................... 166

## Widget Library

- Images ....................................................................................................................... 167
- Marquees ................................................................................................................... 167
- Text ............................................................................................................................ 167
- Panels ......................................................................................................................... 167
- Gauges ....................................................................................................................... 167
- Video .......................................................................................................................... 167
- Weather Applet ......................................................................................................... 167
- More to Come ............................................................................................................ 167

## Sample Dashboards

- ................................................................................................................................. 169

# 14. Storyboards

- Creating a New StoryBoard ....................................................................................... 171
- Adding Dashboards ................................................................................................... 172
- StoryBoard Transitions ............................................................................................. 173
- Conditions ................................................................................................................ 173
1. Introduction / About This Guide

*Smartware Pangaea,* also known as *Pangaea,* is a software platform for collecting and reporting information for a wide range of devices and systems.

**About This Guide**

This guide is intended for all users of Smartware Pangaea. Please refer to the table of contents for a complete list of chapters and topics.

Before beginning, it is recommended that you review the following chapters:

- For information on installing Pangaea, refer to *Chapter 2: Installing and Licensing Pangaea*
- For information on installing and configuring Microsoft SQL Server, refer to *Chapter 3: Installing and Configuring Microsoft SQL Server*
- For a general overview of Pangaea, refer to *Chapter 4: Overview of Pangaea*

The chapters after these highlight individual features, data collectors and tools in Pangaea in more detail.

**Quick Start Guide**

If you want a sample walk though of the general steps involved in using Pangaea, refer to the separate *Smartware Pangaea Quick Start Guide.*

**To Learn More about Smartware Pangaea**

Many of the topics covered in this Guide are better illustrated through visual examples. To that end, our video training sessions are available for viewing and downloading from our web site. We encourage you to use these videos as part of your training.

**To Contact Us**

Our technical support team is available weekdays from 8 am to 5 pm eastern time at (716) 213-2222. You may also visit our web site at [http://www.smartwaretech.com](http://www.smartwaretech.com) or email us at techsupport@smartwaretech.com.
2. Installing and Licensing Pangaea

Before you install Smartware Pangaea, please review the following sections that note a few simple, yet very important prerequisites and configuration issues.

**Workstation System Requirements**

Smartware Pangaea will run on most any modern Windows-based PC. The following are the minimum and recommended system requirements:

- Windows XP or Windows 7 (32-bit or 64-bit)
- 1 GHz Processor (2 GHz recommended)
- 2 GB RAM (4 GB recommended)

Certain features, such as reporting, also require the following:


Be sure to install all recommended Windows updates, including the Microsoft .NET Framework Version 4.0.

**Before You Install Smartware Pangaea**

You should install or configure the following components and applications before you install Smartware Pangaea.

*Install Microsoft .NET Framework (Version 4.0)*

You should have installed on your machine all available updates and service packs from Microsoft. Specifically, you must have Version 4.0 of the Microsoft .NET Framework installed. The .NET Framework is a run-time environment for modern Windows programs, and generally does not interfere with any other aspect of the operating system.

Each version of the .NET Framework is independent of any others, and installing a newer one does not replace older ones. At the time of this writing, Version 4.0 may be an automatic update through Windows Update, but it might be an optional one instead. You may need to choose it explicitly from the optional update list.

- On a newer machine, you may only have Version 4.5 installed, in which case you must still install Version 4.0.
• You can also download and install Version 4.0 of the .NET Framework directly from Microsoft’s web site. Do a search on the phrase “Download Microsoft .NET 4.0” to quickly find the appropriate page.
• To determine which versions of the .NET Framework are installed, go to ADD OR REMOVE PROGRAMS from the Windows Control Panel.
• It is strongly recommended that you DO NOT uninstall other versions of the .NET Framework. There may be other programs installed on the machine that rely on it.

Installing Smartware Pangaea
The latest release of Smartware Pangaea can be found on our web site at www.smartwaretech.com. Click on the link for the Pangaea page, and review the Downloads list on the bottom half of the page. There you will find the latest setup file, along with a number of documents regarding new features and other current topics.

• Download the SMARTWARE PANGAEA SETUP V1.0.XX.MSI installation file.
• Run it and follow its instructions.

Automatic Updates
When you launch Smartware Pangaea, it will check to see if an updated version is available. If so, you will be given the opportunity to download and install the new version. This feature is only available if the machine is connected to the internet.

Registering Smartware Pangaea
Each copy of Smartware Pangaea needs to be licensed before it can be used. To activate a license on a machine you will need a user account login (your e-mail address and a password) and a 9-digit passcode for a license account (from our sales and support department or an Account Administrator in your organization).

The procedure for licensing depends on whether the machine being licensed is connected to the internet.
**Licensing a New Computer**
When you start Smartware Pangaea when it is unlicensed, the Product License Registration dialog will automatically open:

- You can also bring this form up at any time by selecting **FILE→PRODUCT LICENSE REGISTRATION**.
Click on the REGISTER LICENSE button. You will be asked for your login information and the 9-digit passcode.

**Note:** The password here is associated with your Smartware Pangaea account, which is the same as the one used by our Smartware Studio software and Network 8000 Documenting Service. It is not the same as the one used by the older Smartware Technologies web site for licensing our Designer Suite 2005 or WorkPlace Pro Utilities (I/A SMART) packages. If you have any questions or confusion, please contact our technical support department.

Click OK and your license will be registered:

- A passcode can only be used one time, though you can give back your license to get a new passcode at any time.
**Offline Licensing (when no internet connection is available)**

Pangaea can also be licensed offline when the machine being licensed is not connected to the internet. This works by generating a *License Request File* from Pangaea on the machine you want to license, transporting that file to a computer which has access to the internet. The file is then uploaded to the Smartware web site, producing a License File that can be downloaded, transferred back to the machine being licensed, and imported into Pangaea.

- Open Pangaea and click the **GENERATE LICENSE FILE** button in the License Offline group box.

A dialog will appear prompting you to save the text file generated by Pangaea.

- After saving that file, copy it to a machine that has internet access.
Open a web browser and go to the Smartware website at www.smartwaretech.com.

On the home page, click the LICENSING button in the upper right corner of the page.

On the next page click on the OFFLINE PRODUCT LICENSING FOR PANGAEA link.

You will be prompted to browse to and upload the License Request File.

You will then be prompted to login to your Smartware account:

![License Request Form]

Enter the information and click REGISTER LICENSE. The request will be processed and you should receive a link to download the generated license file.

![Download License Key File]

Transport this back onto the machine that you wish to license.

In Pangaea’s Product License Registration form, click License from File.

Navigate to the License File and click Open. Pangaea will now be licensed.

**Updating a License**

The license needs to be updated periodically. This allows us to automatically check for system updates and to enable new features. In most cases, Smartware Pangaea will update itself automatically, continually extending the license period out 90 days any time it can connect to the internet.
If you add new modules or features to an existing license account, you may need to update the license explicitly. Simply click the Update License button.

- You can also update a license using the Offline Licensing procedures described in the previous section

**Moving a License to another Computer**

To move your license from one computer to another (from an office desktop to a home laptop, for instance), you simply give back the license from the first machine by clicking the Give Back License button in the License Registration dialog.

This will deactivate the license on the first computer, and return to you a new 9-digit passcode. You can then use this new pass code to license a different computer using the procedures detailed in *Licensing a New Computer*.

**Changing the Registered User on a Workstation**

If a machine is reassigned to a different user, you should update the license to reflect the new user.

To change the user:

- Give Back the license (which will give you a new passcode), then relicense the machine using the new user’s e-mail address and password.
3. Installing and Configuring Microsoft SQL Server

Each Pangaea Site is stored in a Microsoft SQL Server database. Almost all setup and communication with the database itself are handled by Smartware Pangaea, but the initial installation and configuration of Microsoft SQL Server needs to be done first.

This chapter will outline some important settings that are required to allow Smartware Pangaea to communicate with SQL Server. It is by no means a complete description of how to setup and configure that program. It will attempt to highlight key steps and note troubleshooting issues that we have discovered in the real world.

Note: As with all software, especially sophisticated server systems such as SQL Server, there are many variables that can affect its ability to work as expected in specific scenarios, including other software that is installed on the server and other Windows Server settings.

If you experience problems setting up SQL Server, we will make every attempt to help you diagnose and resolve your problem. We cannot, however, guarantee that we can make SQL Server function on every specific server. In some cases, our recommendations may include using a different server machine.

What is SQL Server?

A Database Server (or Database Management System [DBMS]) is a software program used by other applications to store and retrieve data. Most sophisticated software packages, such as Accounting Packages, use a database server as their storage system. There are a number of popular Database Servers on the market, including Oracle, IBM’s Cloudscape, and of course Microsoft’s SQL Server.

SQL (pronounced S-Q-L or very often ‘sequel’ is a language used by most modern Database Servers to add and retrieve the data. In general, a SQL Server refers to any Database Server that uses the SQL language. In common parlance, however, SQL Server is most often used to refer specifically to Microsoft SQL Server.

From herein, the term SQL Server will likewise refer specifically to Microsoft SQL Server.
SQL Server Requirements

This section will help you determine which version and edition of SQL Server you should use.

Which Version of SQL Server?

Smartware Pangaea is designed to work with Microsoft SQL Server (2005, 2008, 2008 R2 or 2012).

- The current recommendation is SQL Server 2008 R2.
- It will not work with Microsoft SQL Server 2000.
- We have found that SQL Server 2005 may have performance issues compared with later version, and should therefore be avoided if possible.

Which Edition of SQL Server?

Microsoft SQL Server comes in many editions under a wide variety of licenses. For the sake of this discussion, we will refer to them as:

- SQL Server Express (2008, 2008 R2 or 2012)
  
  A free version of SQL Server that Microsoft makes available to everyone to download from their web site. While it does have some limitations regarding the size of a single database or the amount of processing cores that the software will utilize, it is quite sufficient for most Smartware Pangaea applications, especially when beginning. A database created in SQL Server Express can be used by the full version of SQL Server as well, so it will be easy to upgrade as your needs evolve.

- SQL Server (2008, 2008 R2 and 2012) (Full Version)
  
  All other licensed versions of SQL Server.

Smartware Pangaea will work fine with the free SQL Server Express. As your database grows, however, it may be necessary to upgrade to a licensed version of SQL Server.

SQL Server Express can also be installed on the same computer as another edition of SQL Server.

Where Should SQL Server Be Installed?

SQL Server will run on most versions of Windows Server, as well as on Windows XP. Although some people install it on its own machine, SQL Server is often installed alongside other server components such as IIS or other applications.
For the purposes of Smartware Pangaea, it is only necessary that the instance of SQL Server be visible to all the machines that will need to access it, including workstations. This connection can be made from a named machine on your Windows domain or VPN, or through a publicly visible IP address.

**Note:** Unless you are an experienced IT professional, you should take great care before installing any software on a server that is integral to your business. Specifically, you should avoid installing new software on a server running:

- Microsoft Exchange
- An Accounting (or other Line-of-Business) software package
- Any software you can’t specifically identify, but could be critical.

**What Does Smartware Pangaea Need from SQL Server?**

Smartware Pangaea will create a new database on the specified instance of SQL Server, along with any tables and queries that it needs. As updates are made to Smartware Pangaea, it will update the database structure as necessary in coordination with your IT administrator.

**What If SQL Server is Already Installed?**

Smartware Pangaea database can certainly be created on an existing SQL Server, and will coexist with any other applications that are storing their data on it. The only consideration should be whether any of the settings that are necessary for Smartware Pangaea’s client to access the data will adversely affect any other programs using the same SQL Server.

If you are going to use an existing SQL Server, please make note of any other application using it before you install Smartware Pangaea database or make any other changes to the SQL Server configurations.

*If you are at all unsure about how an existing server is being used, do not install or change any configurations without consulting your network administrator.*

**Installing SQL Server**

In general, you will want to refer to Microsoft’s documentation on how to initially install SQL Server.

Before you begin the install (and again after SQL Server is installed), you will want to review the later sections in this chapter for information on configuring SQL Server to work with Smartware Pangaea. Some of the settings can be made during the initial installation, though they can usually be changed after the installation.
**Installing Microsoft SQL Server (Full Edition)**

If you have a license for one of the licensed version of Microsoft SQL Server, refer to its setup instructions for details on initial installation.

Be sure to install the optional *SQL Server Management Studio*, a separately installed tool which is a front-end for viewing, editing and configuring the SQL Server databases. If SQL Server came pre-installed and you can’t find the original installation disks, the Express edition of *SQL Server Management Studio* can be installed instead (refer to the next section).

**Installing Microsoft SQL Server Express Edition**

You can download the free *Microsoft SQL Server Express Editions* from our web site at [www.smartwaretech.com](http://www.smartwaretech.com) or from Microsoft’s web site at [www.microsoft.com](http://www.microsoft.com). As the pages tends to move, you should do a web search, such as "SQL Server 2008 R2 Express Download" to find the current download location.

You will also want to install the corresponding *SQL Server Management Studio Express*, which is a front-end for viewing, editing and configuring the SQL Server databases. In later releases (such as 2008 R2 and 2012) it is included as a component of the SQL Server installation (be sure to select it as an option to install). For older versions you can find the separate installation on the Microsoft web site.

---

*We have included a tools that will download and initiate the installation of SQL Server Express 2008 R2. Go to File ➔ Install Microsoft SQL Server Express.*

**Configuring SQL Server for Remote Access**

The default configuration of SQL Server is intended for it to be used only on the server on which it is installed. Smartware Pangaea is also designed to have the workstation running Pangaea communicate directly with the SQL Server on another machine, so you will need to update some settings in order to make this possible.

These settings include:

- Enable SQL Server Browser Service
- Enable TCP/IP
- Mixed Mode Authentication
- Allow Remote Connections
You may also need to configure your firewall to allow the following processes to pass through:

- SqlServer
- SqlBrowser

Once you’ve made these changes, you may need to

- Restart the SQL Server (not the computer itself).

Refer to the following sections for step-by-step details on all these settings. In some cases the names of folders and menu items may or may not include the SQL Server version (2005, 2008 and/or Express).

**Enable SQL Server Browser Service**

To enable the SQL Server Browser Service:

1. Open up the following program from the Windows Start Menu’s PROGRAMS group:
   
   PROGRAMS⇒MICROSOFT SQL SERVER [2008]⇒CONFIGURATION TOOLS⇒SQL SERVER CONFIGURATION MANAGER

3. Select SQL SERVER BROWSER in the right pane.

4. Right-click on the SQL SERVER BROWSER entry and select PROPERTIES:
5. On the SERVICE tab, change the Start Mode to Automatic:

If you receive an error message, refer to Step 7 of this sub-section for troubleshooting information.
6. On the LOG ON tab, select the "Network Service" BUILT-IN ACCOUNT and click the START button to start the service.

![SQL Server Browser Properties](image)

7. If you receive an error, such as:

"The service cannot be started, either because it is disabled or because it has no enabled devices associated with it. [0x80070422]

you may need to do the following:

a) Open the Windows Control Panel
b) Open the ADMINISTRATIVE TOOLS
c) Open the SERVICES tool
d) Double-click the SQL SERVER BROWSER service
e) On the GENERAL tab, change the STARTUP TYPE to AUTOMATIC
f) Click the START button.
Enable TCP/IP
To allow TCP/IP access to SQL Server:

1. Open up the following program from the Windows Start Menu’s PROGRAMS group:

PROGRAMS ➔
MICROSOFT SQL SERVER [2008] ➔
CONFIGURATION TOOLS ➔
SQL SERVER CONFIGURATION MANAGER

1. Select PROTOCOLS FOR SQLEXPRESS (or MSSQLSERVER) in the left tree under the SQL SERVER [2005] NETWORK CONFIGURATION item.

- The ‘SQLEXPRESS’ or ‘MSSQLSERVER’ in the name refers to the default names of the SQL Server instance, as specified when SQL Server was installed. This name may be different on your server.
- On 64-bit systems, you may also see two SQL SERVER NETWORK CONFIGURATION items, one marked as “(32bit)”. Be sure to select the correct one based on your SQL Server installation.

2. Right-click on the TCP/IP item in the right pane and select ENABLE.
Connecting to the SQL Server using SQL Server Management Studio

The next settings need to be made using the SQL Server Management Studio tool.

To launch SQL Server Management Studio and connect to the SQL Server:

1. Open up the SQL Server Management Studio from the Windows Start Menu’s PROGRAMS group:

   PROGRAMS ➔
   Microsoft SQL Server [2008] ➔
   SQL Server Management Studio [Express]

2. You will be prompted to connect to the SQL Server:

If you are on the same machine where the SQL Server is installed, you should see the name of the server listed in the SERVER NAME list. If not, choose the BROWSE FOR MORE… option from that list and find the server directly.

- Note the specific format of the Server name (in this case, “XPVM\SQLEXPRESS”). You will need it when setting up the database from Smartware Pangaea’s setup wizard.

Click CONNECT to connect to the SQL Server.
**Mixed Mode Authentication**

Smartware Pangaea will communicate with SQL Server using a built-in SQL Server account that it will create. Allowing this along with the standard Windows Authentication is called “Mixed Mode Authentication.”

To configure SQL Server to allow Mixed Mode Authentication:

1. Connect to the SQL Server using *SQL Server Management Studio*, as outlined in the previous section.

2. In the left pane (OBJECT EXPLORER), right-click on the name of the SQL Server and select PROPERTIES:
3. In the **SERVER PROPERTIES** dialog, select the **SECURITY** page:

![Server Properties dialog](image)

4. Under **SERVER AUTHENTICATION**, choose the **SQL SERVER AND WINDOWS AUTHENTICATION MODE**:

![Server authentication options](image)
**Allow Remote Connections to the SQL Server**

To allow remote connection to the SQL Server:

1. Connect to the SQL Server using *SQL Server Management Studio*, as outlined in the previous section.

2. In the left pane (OBJECT EXPLORER), right-click on the name of the SQL Server and select PROPERTIES:
3. Select the CONNECTIONS page:

4. Under the REMOTE SERVER CONNECTIONS heading, check the ALLOW REMOTE CONNECTIONS TO THIS SERVER checkbox:
**Restarting the SQL Server**

Once you’ve applied these changes, you will need to restart the SQL Server service. You do not need to reboot the computer itself.

**Note:** *If other applications are or may be using the same SQL Server, the database will become temporarily unavailable to them. This can cause unexpected or harmful results. You may want to consult the application’s publisher before restarting the server.*

To restart the SQL Server:

1. Connect to the SQL Server using *SQL Server Management Studio*, as outlined in the previous section.

2. In the left pane (OBJECT EXPLORER), right-click on the name of the SQL Server and select **RESTART**:
Opening up the Firewall

Depending on your network configuration, you may need to open up your firewall to allow the Smartware Pangaea workstations to communicate with the SQL Server.

Note: Changes in the firewall settings for your network should only be done by an authorized IT technician or administrator.

The specifics of each different type of firewall are beyond the scope of this document. You will, however, need to allow access to the following two programs:

C:\Program Files\Microsoft SQL Server\90\Shared\SqlBrowser.exe

Note that the “90” part of the path will vary from version to version (‘80’ is SQL Server 2005, ‘90’ is SQL Server 2008, etc.)

C:\Program Files\Microsoft SQL Server\MSSQL.2\MSSQLBinn\SqlServr.exe

Note that the “MSSQL.2” part of the path for the SqlServr.exe file will vary from server to server.
4. Overview of Pangaea

This chapter will introduce the various elements of the Pangaea application, its elements and its user interface. The chapters that follow discuss each of these elements in greater detail.

- If you want a sample walk though of the general steps involved in using Pangaea, refer to the separate *Smartware Pangaea Quick Start Guide*.

The Pangaea User Interface

The main form in Pangaea is designed to act as your workspace. It is comprised of a tree that displays all of your *Site Databases* along with the objects (also called nodes) you have created within those Sites, such as *Data Collectors* or *Reports*.

On the right side is a *Hints Panel* to provide you quick information about the selected node and guide you through the most common tasks in Pangaea.
Pangaea Objects

Each Site and the Objects within it are represented in the Site tree. There are many different kinds of objects in Pangaea, including:

- Sites
- Data Collectors
- Reports
- Dashboards

You can also create *Folders* to organize and store other objects.

All of the actions associated with an Object, both general (such as **CUT**, **COPY** and **PASTE**), as well as those that are specific to certain types of Objects (setting the **DELIVERY PROPERTIES** of a Report) can be accessed by right-clicking the object in the tree and selecting from the menu.

![Pangaea Tree and Menu](image)

- To add a new object to a Site or Folder, right click on that object and select from the ADD menu.

**Sites**

A *Site* is the root Object in Pangaea. It represents a SQL Server database where all of the objects you create in Pangaea, as well as all the data (such as collected points) are stored.

- You can connect to a Site database on the same workstation as Pangaea, or on a remote SQL Server.
- To create a new site, select **FILE**→**CREATE NEW SITE**.
- To connect to an existing site, select **FILE**→**CONNECT TO EXISTING SITE**.
Refer to the later chapter on *Pangaea Sites* for more detail.

**The Message Log**
All Pangaea Sites have a single Message Log object. It is used to store messages that may be generated due to errors in other objects.

**Data Collectors**
A *Data Collector* is an object in Pangaea which allows you to collect data from one or many devices over a period of time. There are simple data collectors like the WebSensor Data Collector, which collects a handful of attributes like *temperature* or *humidity* from a WebSensor device on a network, and there are more complex data collectors like the Niagara R2 or Ax Data Collector, which can collect thousands of values from a sophisticated HVAC control device.

A partial list of the available Data Collectors includes:

- Niagara R2 Logs
- Niagara Ax Histories
- Niagara R2 Live
- Niagara Ax Live
- WebSensors
- NOAA Weather Information
- Manual Data Collector

Each Data Collector has its own interface and setup options, which are discussed in their individual chapters later in this Guide.

**Live vs. Logged Data Collectors**
There are two different kinds of Data Collectors in Pangaea: *Live* and *Logged*. These terms refer to whether the data being collected represents snapshots of the data at the moment of collection (Live), or whether the Data Collector is caching data records from a system that itself is already logging data.

- Examples of Live Data Collectors include the WebSensors, NOAA Weather, Niagara R2 Live and Niagara Ax Live
- Examples of Logged Data Collectors include the Niagara R2 Logs and the Niagara Ax Histories.
Reports

Reports in Pangaea are used to take data logged by Data Collectors within a site and display that information in a neatly formatted multi-tab report, either on the screen or into an Excel Workbook.

- You can create a large number of report tabs. Each tab can show a different set of point values.
- Each column of the report represents one point value collected from a data collector.
- Each row of the report shows corresponding values for those points from a single timestamp.
- You can mix points from any source on the same report.
- Units for point values (e.g. °F or CFM) are carried over as formatting information into the report while leaving the data unchanged and available for further analysis and transform.
- Change of State points (Binary or Boolean values) can be mixed with interval points, and can optionally show the timestamp of each change of state.
- You can create rollup, or aggregate report tabs, showing averages and minimum/maximum values for points over hourly, daily, weekly or monthly periods.
- You can add custom calculated columns using spreadsheet-like formulas and expressions.
- Reports can be scheduled to be automatically run and the Excel workbook emailed to a list of people at regular times.

Dashboards

A Dashboard is a custom designed web page designed to show a set of key information about a building, system, network or any other set of related points. You build the dashboard from a wide variety of built-in Widgets, such as text, gauges, thermostats, images, scrolling marquees, weather forecasts and even video feeds.

- Dashboards are created and edited on your workstation.
- Templates for common energy dashboards and other display will be made available for use and customization.
- When complete, you can “publish” your dashboard to our Hosted Dashboard System (monthly subscription required). When the dashboard is brought up in an end-users web browser, our server will contact your database to get the latest values to display.
- Dashboards will update the values automatically on a frequent basis, such as every 15 seconds.
**Storyboards**

You can also link up multiple dashboards to be displayed in a rotating fashion by creating a Storyboard. When viewing a storyboard, each dashboard page is displayed for a specified amount of time before automatically transitioning to a different page.

- You can also use logic based on the values of your data points to change the order which pages are displayed. For example, if an alarm condition is detected you could force the storyboard to go right to an alarm page.

**Scheduling Tasks**

Data Collectors and Reports can be run at any time (“live”, or “on-demand”) by opening the node on the tree and using its commands. This will collect the latest data values or run the report with the latest data. This is fine when you are setting up the system and developing the reports, but eventually you will probably want these tasks to be done automatically on a regular basis, such as once a night or once a week.

- To configure an Object to run at a scheduled time, right-click it in the tree and select **SET COLLECTION SCHEDULE** or **SET REPORT SCHEDULE**.

![Edit Schedule](image)
You can also view and edit all the Scheduled tasks at once by going to TOOLS→SET SCHEDULED TASKS.
Scheduled Tasks will not run unless Pangaea is running and has been put into Task Scheduler mode. Select **TOOLS**→**RUN SCHEDULED TASKS** to bring up the Task Control Panel.

- You can lock the Scheduler (optionally with a password) to prevent other users who may have access the machine from inadvertently shutting down the application.
- If the workstation itself is locked, the Task Scheduler will continue to run.
- You should not log off of the workstation, as certain tasks (such as generating reports to Excel and sending emails) may depend on the logged in user’s permission, depending on your network security configuration.

**Data Points**

A Data Point, or simply a Point, is the term used to represent a value collected from some system over a period of time, such as Outside Air Temperature, Supply Fan Status or Gas Meter Reading.

- Points are generally created and defined by specific Data Collectors when you first collect its data.
- The point consists of the **Point Properties** (Point ID, Name, Data Type, Description, Units, the source Data Collector, etc.) as well as the full list of the values that have been collected for it.
- Each point has a specific data type: Double (real numbers), Integer, Boolean (true/false), Multi-State (e.g., Off, Slow, Fast, Turbo), String (text) or Date (with or without time)
• Each *Point Value* consists of the timestamp of the data, the value and a status of that value (e.g., some Data Collectors may indicate that the value may not be accurate due to a connection error in the source system).

You can view a list of points from numerous places:

• When working within a Data Collector, the points are usually shown in a tree or list.
• If you right-click on a Data Collector in the Pangaea tree, you can select **VIEW POINTS** to view the points created by that Data Collector.
• If you right-click on a Site in the Pangaea tree, you can select **VIEW POINTS** to view the points contained in that site. You can also select **TOOLS** → **VIEW POINTS** to see all of a site’s points.

When viewing a list or tree of points, you can almost always right-click on the line or node to **VIEW POINT DATA** or to **EDIT POINT PROPERTIES**.
5. Pangaea Sites

All of the Objects you create in Pangaea such as Data Collectors and Reports are stored in a Site. The Site and all its associated objects and data values are stored in a SQL Server database, so creating or connecting to a site is essentially creating or connecting to a SQL database.

- Refer to the earlier Chapter 3: Installing and Configuring Microsoft SQL Server for more details about SQL Server.
- You can easily download and install the free Microsoft SQL Server Express from Pangaea by selecting FILE→INSTALL MICROSOFT SQL SERVER EXPRESS.
- To create a new site, select FILE→CREATE NEW SITE.
- To connect to an existing site, select FILE→CONNECT TO EXISTING SITE.

Creating a New Site

When you first launch Pangaea, your workspace will be empty, as shown below. The Hints panel will instruct you to either create a new Site or connect to an existing one before creating any Data Collectors or Reports.

To create a new site, select FILE→CREATE NEW SITE or click the link in the Hints panel.
**Step 1: Is Microsoft SQL Server Installed?**
If you are planning on creating the SQL Server database on the same machine as Pangaea and have not already installed the SQL Server software, you can download and launch the installed from here.

If you already have SQL Server installed locally or remotely click NEXT.

**Step 2: Select the SQL Server**
You will need to tell Pangaea the name or IP address of the SQL Server.
Step 3: Specify How to Log Into SQL Server to Create the Database
Pangaea will need to log into the SQL Server to create the new database. You can use either Windows Authentication or SQL Server Authentication.

Step 4: Test the SQL Connection
If SQL Server is configured properly, you should now be able to connect to the SQL Server.
Click the TEST CONNECTION button to test the connection. If the connection fails:

- Review the error message for an explanation of the problem.
- Review the SQL Server settings outlined in the earlier *Chapter 3: Installing and Configuring Microsoft SQL Server*.

**Step 5: Specify the Database Name and SQL Account to Create**

The default settings should suffice for most users.
**Step 6: Create the SQL Database**

Pangaea is now ready to create and set up the SQL Server database.

Click the CREATE DATABASE button to begin.

If successful, Pangaea will create your new site and return you to the main form, where the new site will appear in the workspace tree.
Connecting to an Existing Site

To connect to an existing Site, select File ➔ Connect to Existing Site.

- If you installed SQL Server locally, you should be able to use the localhost connection with Windows Authentication.
- If using a remote server, the person who configured that server should be able to provide you with the appropriate connection information.
Once you have filled in all of the criteria, you can test the connection by clicking TEST CONNECTION. If successful, press OK and your Site will appear in the main workspace tree.

![Smartware Pangaea interface](image)

**Backing Up a Site Database**
As with all important data, you should back up the site’s database on a regular basis. Remember that not only is the data collected by Pangaea stored in the site’s database, but also all the configurations of the Data Collectors, Reports and Dashboards.

**Using SQL Server’s Maintenance Plans**
SQL Server’s *Maintenance Plan* feature can be used to configure regular and automatic backups with full control over permissions and other network issues.

- The *Maintenance Plan Wizard* can be used to set up the plan. It is available through the SQL Server Management Studio.
- Search the web for “SQL Server Maintenance Plan” for more information.
**Backing up a Local Database**

For databases located on the same machine as Pangaea, you can quickly get a full backup of the site’s database by right-clicking on the Site’s node in the workspace and selecting **Backup Site Database**.

- Select a folder in which to save the backup file and click **Backup Database**.

The Windows account under which SQL Server is running must have permission to the folder. If you receive error messages regarding such permissions, try selecting the default Backup folder for your SQL Server. The folder varies from machine to machine, depending on the version of Windows and SQL Server, but will be similar to:

```
C:\Program Files\Microsoft SQL Server\MSSQL10.SQLEXPRESS\MSSQL\Backup
```

**Restoring a Site Database**

If you are relocating a Site database from one server to another, you will first need a backup of the database using one of the methods in the previous section.

To restore this backup, you should use SQL Server Management Studio on the new server.

- Open SQL Server Management Studio and Connect to the SQL Server.
• Right-click on the *Databases* folder and select RESTORE DATABASE.

![Restore Database dialog box](image1.png)

• Enter the name of the database you want to create from the restore.

• Select the FROM device option and click the dots to select the backup file.

![Specify Backup dialog box](image2.png)
• Choose the FILE media and click the ADD button to browse to the folder:

![Locate Backup File - XPVMSQLEXPRESS](image)

• For the easiest restore, you will want to copy your backup file into the default Backup folder that SQL suggests. SQL Server is guaranteed to have the appropriate permission to this folder.
- Select your .BAK file and click OK.

- Be sure to check the box marked RESTORE next to the file name. Then click OK to restore the database.
If you are relocating the database to a different server than the one on which it was created, the login information for the database will likely need to be recreated.

- You may need to create a *PangaeaUser* account on the SQL Server itself under the Security/Logins folder:

```
<table>
<thead>
<tr>
<th>Security/Logins</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUILTIN/Administrators</td>
</tr>
<tr>
<td>NT AUTHORITY/SYSTEM</td>
</tr>
<tr>
<td>PangaeaUser</td>
</tr>
<tr>
<td>Server Roles</td>
</tr>
<tr>
<td>Credentials</td>
</tr>
<tr>
<td>Server Objects</td>
</tr>
<tr>
<td>Replication</td>
</tr>
<tr>
<td>Management</td>
</tr>
</tbody>
</table>
```

- You will also need to delete and recreate the *PangaeaUser* account on the restored database from the database’s Security/Users folders. Be sure to give that user full permission (db_owner) on the database.

```
<table>
<thead>
<tr>
<th>Security/Logins</th>
</tr>
</thead>
<tbody>
<tr>
<td>db_owner</td>
</tr>
<tr>
<td>guest</td>
</tr>
<tr>
<td>INFORMATION_SCHEMA</td>
</tr>
<tr>
<td>sys</td>
</tr>
<tr>
<td>PangaeaUser</td>
</tr>
<tr>
<td>Roles</td>
</tr>
<tr>
<td>Schemes</td>
</tr>
</tbody>
</table>
```
6. Data Points

A Data Point, or simply a Point, is the term used to represent a value collected from some source over a period of time, such as Outside Air Temperature, Supply Fan Status or Gas Meter Reading.

- Points are generally created and defined by specific Data Collectors when you first collect its data.
- The point consists of the Point Properties (Point ID, Name, Data Type, Description, Units, the source Data Collector, etc.) as well as the full list of the values that have been collected for it.
- Each Point Value consists of the timestamp of the data, the value and a status of that value (e.g., some Data Collectors may indicate that the value may not be accurate due to a connection error in the source system).

You can view a list of points from numerous places:

- When working within a Data Collector, the points are usually shown in a tree or list.
- If you right-click on a Data Collector in the Pangaea tree, you can select VIEW POINTS to view the points created by that Data Collector.
- If you right-click on a Site or Folder in the Pangaea tree, you can select VIEW POINTS to view the points contained in that site or folder. You can also select TOOLS  VIEW POINTS to see all of a site’s points.
- When viewing a list or tree of points, you can almost always right-click on the line or node to VIEW POINT DATA or to EDIT POINT PROPERTIES.

Viewing Point Data

In most scenarios, to view the data for an individual point, right-click on it and click VIEW POINT DATA.
The dialog shown below will appear displaying all of the data that has been logged for that point in addition to options for adding, editing, and clearing records.

<table>
<thead>
<tr>
<th>Time Stamp</th>
<th>Value</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>05/22/2013 10:10:27</td>
<td>77.30°F</td>
<td>OK</td>
</tr>
<tr>
<td>05/22/2013 10:10:27</td>
<td>80.00°F</td>
<td>OK</td>
</tr>
<tr>
<td>05/22/2013 14:10:27</td>
<td>75.50°F</td>
<td>OK</td>
</tr>
</tbody>
</table>

**Point Properties**

To edit the properties of a point, right click on it and select **EDIT POINT PROPERTIES**.
• Some of the point properties can be changed, including Point Name, Description and Column Header.
• The Column Header is used in reporting as the title of the data column in the table or chart.
• Each point is assigned an ID, which helps differentiate different points that might have the same Name.

Point Data Types
Each point in Pangaea has a specific Data Type which signifies the type of data it can collect and store. The type is fixed when the point is created, generally based on the source of the data. The types include:

- Double (or Analog) Real numbers, which can include decimal places.
- Boolean (or Binary) True or False (or 0 and 1) values, that usually represent binary states such as Off/On or Closed/Open
- Multistate A value from a list of discrete options (e.g. Off, Slow, Fast, Turbo), represented by a set of integers.
- Integer Whole numeric values without decimal places
- String Text data
- Date Date and time values

Formatting Point Values
There are additional properties for each data type that tell Pangaea how to format the point’s values when they are shown on the screen or in reports.

• For Double values you can specify the Category and display Units, such as milliamps, degrees Fahrenheit or dollars. Values will be formatted accordingly using the standard abbreviations (e.g. 6.7 mA, 44 °F or $567.89). You can also specify the number of decimal digits to show.
• For Boolean values you can assign a piece of text to represent True and another for False, such as Open and Closed, On and Off, or Alarm and Normal.

• For Multistate values you specify the list of valid integer values that the point can have, and for each value the text to display.

• For Date values you can specify a format string that includes the date and/or time in almost any conceivable format. You can choose from the pre-defined list or enter your own. For a complete list of format options, search the internet for “custom .net date format strings”.

• Integer and String values have no special formatting properties.
Viewing List of Points

When you view a list of points (by right-clicking any data collector, folder or site and selecting View Points, or selecting Tools→View All Points), the list will show all of the point’s properties, including Data Type, Format, Data Collector and Point ID.

- Right-click on the line or node to View Point Data or to Edit Point Properties.

Point Path

For more complex data collectors (e.g. Niagara R2 and Ax), points are often organized into a tree structure. When collected into Pangaea, the Point Name is usually based only on the name of the point without regard for its location within the data source’s tree. That information is instead stored as the Point Path property, as seen in the image above. This path is used to recreate the tree structure of the original data source when allowing you to select points in other objects, such as reports.
7. Data Collectors

Data Collectors are the Pangaea objects used to get data from outside sources and store them in the site database. Each type of data collector is designed for a specific data source, such as:

- NOAA Weather Data
- WebSensors
- Niagara R2 Logs
- Niagara Ax Histories
- Niagara R2 Live values
- Niagara Ax Live values

This chapter will review the basics of all Data Collectors and the details of the most basic. Later chapters discuss the more detailed Data Collectors, such as those that get data from the Tridium Niagara systems.

Creating a Data Collector
As with the other objects in Pangaea, you can add a Data Collector to the root of the Site tree or in a folder you create. To add a new Data Collector:

- Right-click on the Site or Folder, select ADD→DATA COLLECTOR, and choose from one of the Data Collectors on the list.
- Choose from one of the Create New links in the Hints panel.

Editing and Configuring a Data Collector
Once created, double-click on the Data Collector in the site tree to open it. Some Data Collectors will prompt you for preliminary information first (e.g., the NOAA Weather Data Collector will ask for the zip code), before opening the Data Collector in its edit mode. Others will go right to edit mode.

When in edit mode, you will generally be able to:

- Specify the configuration information (such as zip code or IP address and login)
- Choose from a list of available points for the data source.
- Read the current values of those points immediately to verify the setup and connection are correct.
- View the values of the points you are collecting for that Data Collector.
**Scheduling a Data Collector for Regular Collecting**

Once the Data Collector has been configured, you will usually want to tell Pangaea to collect the data on a regular basis.

- For some data sources that cache their data, such as Niagara R2 Logs or Niagara Ax Histories, you will often collect the data just once a day.
- For data sources that do not cache their data, you will collect as often as necessary to capture the data you need (e.g., hourly weather data or Websensor temperature data once every 15 minutes).

To set the Schedule for a Data Collector, right-click on the Data Collector in the Site tree and select **SET COLLECTION SCHEDULE**.

**Note**: The Task Schedule must be running in order for data to be collected based on the schedule. Refer to the later chapter on Task Scheduling for more details.

**Viewing Point Data from a Data Collector**

Most Data Collectors will show the points they are collecting in a list or tree. If you right-click on the point in that list or tree, you will have the following commands:

- **EDIT POINT PROPERTIES** – view the properties of the point
- **VIEW POINT DATA** – view and edit the values already collected for the point

Refer to the earlier chapter *Data Points* for more information.

**Manual Data Collector**

A *Manual Data Collector* in Pangaea is a single point to which you add individual records, one at a time, by hand. It is useful in cases where the values change infrequently and no automated source of the data exists. One example is a utility cost factor (e.g., dollars per kilowatt of electricity) that may only change once per month. Such a factor can be used in a calculated column or a report to translate utility usage into utility cost.
The first time you open a new Manual Data Collector, you will be prompted to enter a name for the new point and choose its data type.

You will then be prompted to enter the optional information standard for all Data Points, such as its description, column heading and format.

**NOAA Weather Data Collector**

The NOAA Weather Data Collector can be used to collect current readings of Temperature and Humidity, as well as two days of forecasted high and low temperatures. The data is collected from the National Oceanic and Atmospheric Administration (NOAA), a federal agency that supplies this public data for the United States at no cost.
The first time you open a new NOAA Weather Data Collector, you will be prompted to enter a Zip Code:

The Data Collector will geocode the zip code and contact the NOAA to determine the nearest weather source:

You can any or all of the six values to collect:

- *Temperature* and *Humidity* are the latest hourly readings.
- *Minimum Temp 1* and *Maximum Temp 1* are the forecasted high and low for the next day.
- *Minimum Temp 2* and *Maximum Temp 2* are the forecasted high and low for the day after that.
After select the points you want to collect, click **READ DATA SAMPLE** to test the connection and configuration and collect the latest value for each point.

- When you schedule the Data Collector, be sure to set the frequency of the collection to hourly to capture all the values.
- If you need actual highs and lows, you can use aggregate functions in a report to determine the Minimum and Maximum values of the actual values throughout a day.

**SmartEdge WebSensor Data Collector**

SmartEdge WebSensors are web-based sensors that read environment or power information and transmit it over any internet connection, wired or wireless.

The first time you open the Data Collector you will be prompted to specify the model number:

- The *EM-08* is an Environmental Monitor that reads the Temperature, Humidity and Illumination in a location.
- The PM models are power meters. The *PM-01* reads a single voltage, the *PM-21* is a single-phase power meter, and the *PM-31* is a three-phase power meter.
To configure the Data Collector, enter the *IP Address* of the WebSensor and select the points you wish to collect:

![Edit EM-08](image1)

Click the **READ DATA SAMPLES** button to test the connection and settings and read the latest values for each selected point:

![Current Readings](image2)

<table>
<thead>
<tr>
<th>Point Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>75.9 °F</td>
</tr>
<tr>
<td>Humidity</td>
<td>58.2 %</td>
</tr>
<tr>
<td>Illumination</td>
<td>26.3 lx</td>
</tr>
</tbody>
</table>
8. Niagara R2 Logs Data Collector

The Tridium Niagara R2 system (which may go by other branded names) is an industry-standard web-based HVAC control system. Pangaea has the ability to collect data from these devices in several different ways.

- If you need to archive data already captured in Log objects, use the Niagara R2 Log Data Collector.
- If you need to capture live values from arbitrary objects and properties, use the Niagara R2 Live Data Collector.

Note: The R2 platform has since been superseded by the Ax platform, which while similar in concept and using similar hardware, is actually completely different software. If using those devices, refer to the later chapter on Niagara Ax Data Collectors.

Overview of the Niagara R2 Platform

The Niagara R2 platform consists of two types of devices:

- A JACE or UNC is a stand-alone hardware platform with a limited amount of memory and storage space running a lightweight operating system with a Java virtual machine.
- An Enterprise Server is a workstation or server machine running a full version of Windows.

Both types of devices run programs, called stations, created with the Tridium WorkPlace Pro software. These stations are structured as a tree of different types of objects representing various things such as field controllers, network configurations, graphics screens or logic and math operations.

In a small building, there may be only a single JACE controlling the whole building and serving up the graphics pages. When two or more JACEs are required, there is usually and Enterprise Server that acts as the global station, serving up the graphics and archiving log data from the JACEs.

Refer to the Niagara R2 documentation, such as the Niagara Standard Programming Reference, for more detail.
Log Objects and the Archive Database

The various Log objects (AnalogLog, BinaryLog, MultistateLog, etc.) are designed to capture a value from somewhere in the station, either on an interval basis (e.g., every 15 minutes) or when it changes (usually used for Binary Logs). The number of records the log keeps is configurable, but is usually no more than a few hundred, representing a few days’ worth.

To extend their capacity, logs can be configured to archive their data to an Archive Database on the Enterprise Server. The Enterprise Server uses a Cloudscape database by default (IBM Cloudscape, now called Apache Derby, is an open source database system embedded in Java programs that requires no additional setup or administration). With additional licensing and setup, some Enterprise Servers can use a Microsoft SQL Server database instead.

There are several common configurations for log objects and the archive database:

- If the JACE is stand-alone, the log objects will eventually fill and generally delete the older records to make room for the new ones.
- If the log objects are in the JACE’s station and they are configured to archive, the JACE holds the most recent records and sends its data to the Enterprise Server’s archive database on a regular (usually daily) basis.
- If the log objects are in the Enterprise Server’s station (capturing values that may have come from the JACE), they are also archived into the Enterprise Server’s archive database.

In this first case where there is no Enterprise Server, Pangaea can serve as the archive database by collecting the data from the log objects before its deleted. For example, if the log holds three days of data, you could use Pangaea to collect from it nightly to ensure you don’t miss any records. In cases where there is an Enterprise Server, Pangaea can server as a backup of the archive (the Cloudscape database has a history of becoming corrupted in R2), as well as making the archive data available to Pangaea.

Creating a New Niagara R2 Log Data Collector

To create a new Niagara R2 Log Data Collector, select the Site or Folder in the site tree where you want it to be created and:

- Select ADD ➔ DATA COLLECTOR ➔ NIAGARA R2 LOGS; or
- Select NIAGARA R2 LOGS DATA COLLECTOR in the Hints Panel.
Loading the Station Backup File

The Data Collector needs a copy of the station’s backup file in XML format (a file generally called config.xml). This must be a backup of the station that contains the actual log objects. Specifically, if the logs are in the JACE’s station but are archiving to the Enterprise Server, you need the JACE’s station backup (though you will use the IP address of the Enterprise Server when you collect the data).

The Data Collector will offer you the choice of downloading the backup directly from the JACE or Enterprise Server or providing an existing config.xml file you have already obtained from the device.

- Depending on the size of the station, the backup could take some time (especially for an Enterprise Server). In these cases, you may want to use the WorkPlace Pro Admin Tool to get a .SNS version of the backup and convert it to XML.
- You have the option of also saving the config.xml file to a local folder when it gets the backup. This is useful if you are creating several data collectors based on the same station.
Once loaded, the Data Collector will be displayed:

- The tree on the left side is a stripped down version of the station’s object tree showing only log objects and the folders that contain them. In this version, all containers are shown as folders, and only folders that contain at least one log somewhere beneath it are shown in the tree. Logs are color coded by data type using the same colors as in WorkPlace Pro.
- The right side includes sections for the JACE or Enterprise Server connection information, archive database configuration and Data Retention options.
- The lower right shows the properties of the Node (Folder or Log) that you currently have selected in the tree.

**Archive Source Properties**

First indicate from where the data will be collected, either the Archive Database on the Enterprise Server (which includes scenarios where the logs objects are located in a JACE but archiving to the Enterprise Server) or the JACE (aka UNC).

In both cases, you must supply the **IP Address** along with the **Username** and **Password** used to log into the station.
If you are collecting from the Archive Database, you can also specify the type of the database. The default is the Cloudscape database, but if the Enterprise Server has been configured to use SQL Server, select that option and enter the name of the SQL Server Database. You can also instruct the collector to command each log to archive its data before the log data is collected, though it depends on the configuration of the log’s archive properties within the station as to what the effect will be.

If you are collecting directly from a JACE, choose the UNC option. This will instruct the collector to contact the JACE directly using the WebUI service’s /log/fetch command.

**Node and Point Properties**

Every time you click on a log or container in the tree view, the form will display information about it in the Node Properties and/or Point Properties group boxes. When you click on a container, the Node Properties group box will show you its properties, as well as how many logs are inside it, how many logs inside it are set for collection, and how many logs inside it have been recorded in the database.

![Node Properties](image)

When you select a log in the tree, information about that log will be displayed in the Node Properties group box. In addition, the Point Properties group box will appear under the Node Properties group box with further detail about things like its data type, its collected record count, and the date and time of the last collected record.

![Point Properties](image)

**Setting the Data Retention Period**

You can choose how many data values are kept for each log. There are three options:
**Number of Days**  Keeps a certain number of days’ worth of data for each log. Records older than this are not collected from the station and any records older than this already collected are deleted.

**Number of Records**  Keeps up to a specific number of data values. As new values are collected, the oldest ones are deleted.

**Forever**  Collects and keeps all data values. On the first collection this may be very time consuming depending on how much data there is in the Archive Database.

- As part of its collection process, the Data Collector will only request and add records that are later than the latest value already collected. For example, if you set the retention to 30 days and collect the data, then change the retention to 60 days, the next collection will *not* go back and get the records from 31-60 days ago. If you needed to fill in that data, you would need to clear the data in the log before recollecting.

**Collecting Data**

Once configured, you can begin to collect data from the logs into Pangaea points.

- To collect from a single log, right-click it in the station tree and select **COLLECT DATA**.
- To collect from all the logs in a folder, right-click it in the station tree and select **COLLECT DATA**.
- To collect from all the logs in the station, right-click the station node in the tree and select **COLLECT DATA**.
After the collection you will receive a report of which logs were collected, how many records were collected from each, and whether there were any errors during the collection:

- To view the data collected right-click on a log in the station tree and select **VIEW LOCAL DATA**.

**Selecting Logs for Collection**

In many scenarios you will want Pangaea to collect the data from a set of logs on a regular basis. In these cases you will want to explicitly select which logs to collect.

- To see which logs are already selected for collection, select **DATA → SHOW ALL SELECTED LOGS**. This will expose them in the tree.
- To collect data from all the selected logs, **DATA → COLLECT FROM ALL SELECTED LOGS**.
**Selecting Individual Logs**

To select individual logs for collection, simply navigate through the station tree and click on the check box next to the names of the logs. When you select a log, the color of the text for that log will change from black to blue. This implies that the log is selected for collection.

**Selecting Multiple Logs**

To collect data for all the logs within a folder, check the check box next to the name of that folder. Checking a folder will automatically select all logs beneath it, showing them as blue.

- If you were to select the checkbox next to the name of the station, then all the logs in the station would be set for collection.
Updating and Synchronizing the Station Tree

If the Enterprise Server or JACE station is updated to include additional logs, you can update the Data Collector by importing a new XML backup of the station and letting Pangaea detect the differences, adding any new logs it finds.

- To synch your Data Collector’s station tree with another config.xml backup, select FILE→SYNCH WITH NIAGARA STATION XML FILE.

You will need to browse to the new config.xml backup file. If necessary, you can create a new, temporary Niagara R2 Logs Data Collector to download the backup from the station (check the Save Backup checkbox to save it locally).

After synchronization, Pangaea will display the results showing all the logs that have been added to your data collector:

Be sure the backup is from the same station as the original.
Synchronizing with Workplace Pro Utilities Files

Pangaea can also synchronize your Niagara R2 Data Collector with a Workplace Pro Utilities Data Collector file (.WPC). This will import the list of the selected logs in the Workplace Pro Utilities file and select them for collection in your Data Collector Station tree.

- To import the selected node list, select File ➔ Import Selected Nodes from WPU (.WPC) File.
- Pangaea cannot import data from a WorkPlace Pro Utilities database.

Browse to the Workplace Pro Utilities file on your computer or. After you have chosen the file, Pangaea will have selected the logs and report how many additional logs have been selected.
9. Niagara Ax Histories Data Collector

The Tridium Niagara Ax system (which may go by other branded names) is an industry-standard web-based HVAC control system. Pangaea has the ability to collect data from these devices in several different ways.

- If you need to archive data already captured as Histories, use the Niagara Ax Histories Data Collector.
- If you need to capture live values from arbitrary objects and properties, use the Niagara Ax Live Data Collector.

**Note:** The Ax platform is a more advanced system than the R2 platform, which while similar in concept and using similar hardware, is actually completely different software. If using those devices, refer to the previous chapter on Niagara R2 Log Data Collector.

**Niagara Ax Configuration**

The Niagara Ax Histories Data Collector collects data stored in Histories. A History is essentially a log of values associated with an object or property in the Niagara station.

- You must configure the History Service in the station. For more details, refer to the chapter About Histories in the Niagara Ax User Guide.

Pangaea collects the data from the station using oBIX. You will need to make sure the JACE or Enterprise Server:

- Is licensed for oBIX.
- Is configured as an oBIX server.

Refer to the Niagara Ax oBIX Guide for full details, specifically

- The chapter oBIX Quick Start, section Server operations, subsection Enable oBIX server operation
- The chapter Niagara AX Obix Concepts, section Obix Server Operation.
Creating a New Niagara Ax Histories Data Collector
To create a new Niagara Ax Histories Data Collector, select the Site or Folder in the site tree where you want it to be created and:

- Select ADD ➔ DATA COLLECTOR ➔ NIAGARA AX HISTORIES; or
- Select NIAGARA AX HISTORIES DATA COLLECTOR in the Hints Panel.

Loading the Station Backup File
The Data Collector needs a copy of the station’s backup file (a file generally called config.bog). This must be a backup of the station that contains the actual objects that have the histories. Specifically, if the histories are in the JACE’s station but are accessed through oBIX to the Enterprise Server, you need the JACE’s station backup (though you will use the IP address of the Enterprise Server when you collect the data).

The Data Collector will offer you the choice of downloading the backup directly from the JACE or Enterprise Server or providing an existing config.bog file you have already obtained from the device.

The GET BACKUP feature only works if there is a config.bog file already stored on the root of the station’s Files folder, which is normally saved there by the Niagara Backup Service. If this service is not installed on the device, you will need to get the backup manually through the Niagara Workbench.
- You have the option of also saving the `config.bog` file to a local folder when it gets the backup. This is useful if you are creating several data collectors based on the same station.

Once loaded, the Data Collector will be displayed:

![Data Collector Screenshot](image)

- The tree on the left side is a stripped down version of the station’s object tree showing only objects with histories and the folders that contain them. In this version, all containers are shown as folders, and only folders that contain at least one history somewhere beneath it are shown in the tree. Logs are color coded by data type.
- The right side includes sections for the JACE or Enterprise Server connection information and Data Retention options.
- The lower right shows the properties of the Node (Folder or History) that you currently have selected in the tree.

**Archive Source Properties**

You must supply the **IP Address** along with the **Username** and **Password** used to log into the station where the histories are stored. This is the station that is configured as the oBIX server.
**Node and Point Properties**

Every time you click on a history or container in the tree view, the form will display information about it in the *Node Properties* and/or *Point Properties* group boxes. When you click on a container, the Node Properties group box will show you its properties, as well as how many logs are inside it, how many logs inside it are set for collection, and how many logs inside it have been recorded in the database.

![Node Properties](image)

When you select a history in the tree, information about that log will be displayed in the Node Properties group box. In addition, the Point Properties group box will appear under the Node Properties group box with further detail about things like its data type, its collected record count, and the date and time of the last collected record.

![Point Properties](image)

**Setting the Data Retention Period**

You can choose how many data values are kept for each collected history. There are three options:

- **Number of Days** Keeps a certain number of days’ worth of data for each history. Records older than this are not collected from the station and any records older than this already collected are deleted.
- **Number of Records** Keeps up to a specific number of data values. As new values are collected, the oldest ones are deleted.
- **All Records** Collects and keeps all data values. On the first collection this may be very time consuming depending on how much data there is in the database.
• As part of its collection process, the Data Collector will only request and add records that are later than the latest value already collected. For example, if you set the retention to 30 days and collect the data, then change the retention to 60 days, the next collection will not go back and get the records from 31-60 days ago. If you needed to fill in that data, you would need to clear the data in the log before recollecting.

Collecting Data

Once configured, you can begin to collect data from the histories into Pangaea points.

• To collect from a single history, right-click it in the station tree and select Collect Data.
• To collect from all the histories in a folder, right-click it in the station tree and select Collect Data.
• To collect from all the histories in the station, right-click the station node in the tree and select Collect Data.

After the collection you will receive a report of which histories were collected, how many records were collected from each, and whether there were any errors during the collection:

• To view the data collected right-click on a history in the station tree and select View Local Data.
Selecting Histories for Collection
In many scenarios you will want Pangaea to collect the data from a set of histories on a regular basis. In these cases you will want to explicitly select which histories to collect.

- To see which histories are already selected for collection, select DATA→SHOW ALL SELECTED HISTORIES. This will expose them in the tree.
- To collect data from all the selected histories, DATA→COLLECT FROM ALL SELECTED HISTORIES.

Selecting Individual Histories
To select individual histories for collection, simply navigate through the station tree and click on the check box next to the names of the histories. When you select a history, the color of the text for that history will change from black to blue. This implies that the history is selected for collection.
Selecting Multiple Histories
To collect data for all the histories within a folder, check the check box next to the name of that folder. Checking a folder will automatically select all histories beneath it, showing them as blue.

- If you were to select the checkbox next to the name of the station, then all the histories in the station would be set for collection.

Updating and Synchronizing the Station Tree
If the Enterprise Server or JACE station is updated to include additional histories, you can update the Data Collector by importing a new backup (config.bog) of the station and letting Pangaea detect the differences, adding any new histories it finds.

- To synch your Data Collector’s station tree with another config.bog backup, select File ➔ Synch with Updated Station Backup.

You will need to browse to the new config.bog backup file. If necessary, you can create a new, temporary Niagara Ax Histories Data Collector to download the backup from the station (check the Save Backup checkbox to save it locally).

After synchronization, Pangaea will display the results showing all the histories that have been added to your data collector:
• Be sure the backup is from the same station as the original.
10. Reports

Pangaea offers the ability to create powerful, dynamic reports integrating values from any of the sources you have used to collect data from within a site. In this chapter we will describe the different types of reports, their use cases and how to create and run them. The next chapter discusses some of the more advanced features of the reports.

Types of Reports

Pangaea offers multiple report types to aid in the data analysis of your data. There are three base types of reports, and several variations of each:

- **Trend Reports**
  - Shows multiple related points over a period of time, such as *Return Air*, *Mixed Air*, and *Discharge Air* temperatures of an HVAC system.
  - Each point is in a column
  - The values associated with different timestamps are shown in each row.

- **Schedule Reports**
  - Shows the latest value a set of similar points in similar systems, such as a set of VAV systems.
  - Each point is in a column.
  - Each system (VAV1, VAV2, etc.) is in a row.

- **Formatted Field Reports**
  - Fills in the latest values (or aggregates) of any points into an Excel worksheet as a template, such as for a LEED Energy report.

Trend Reports are the most basic report, and are used in most of the examples in this chapter. Schedule Reports and Formatted Field reports are discussed in depth in the next chapter, but the next sub-sections describe the essential differences and features of the three types in more detail.

**Trend Reports**

Trend Reports are the most basic report used for commissioning and analysis of points in a system.

- Shows multiple related values (points) over a period of time, such as *Return Air*, *Mixed Air*, and *Discharge Air* temperatures of an HVAC system.
- Each point becomes a column of the report
- Each row represents a point in time (timestamp) with the values of each point at that time.
- There can be multiple tabs to group together points from different systems.

When creating Trend Reports:

- Each tab can be configured as an Aggregate report, grouping the values by hour, day, week or month.
- Reports can be configured as Exception reports, showing only rows where a specified exception condition is true.
- You can also include charts for each worksheet, either on the same tab or a separate one.
**Schedule Reports**

Schedule Reports are designed to show a snapshot of the status and health of multiple systems in a single report. One common example is a set of VAV systems, which are often engineered as a single system and duplicated within the control system, and so have the same named points in each instance of the control system.

In comparison to a Trend Report:

- Where Trend Reports allow you to build up multiple *tabs* of points to display, Schedule Reports let you build up multiple *rows*.
- Where Trend Reports consider each point to be a *column*, Schedule Reports treat each point as a *cell*.
- Each point is still a column of the report, but only the first row is used to define the column headings in all rows.
- In each row, the points selected are assumed to align with the points selected in the first row. It is possible to have empty cells in cases where not every system has every point.
- There will only be a single tab in the output of a Schedule Report.
- Reports can be configured as Exception reports, showing only rows where a specified exception condition is true.
- As the report shows only the latest values, you cannot create aggregate reports or charts with a Schedule Report.

Refer to the next chapter on *Advanced Reporting Topics* for more details on Schedule Reports.
Formatted Field Reports

Formatted Field Reports are used in cases where you need to fill data into an existing form (e.g. a state-specified LEED Energy report) or a custom layout.

In comparison to a Trend Report:

- Where Trend Reports treat each point as a column, Formatted Field Reports treat each point (or calculated value) as a field.
  - The Fields in a Formatted Field Report can include more sophisticated aggregate functions that allow you to extract individual monthly usage from a point with accumulated meter data.
- Formatted Field Reports require an Excel template to be used. With Trend Reports they are optional.
- You can mix Trend Reports and Formatted Field reports together. The settings are on a per-tab basis.
- As the report shows only the latest values, charts generally are not used with Formatted Field Reports.
- Formatted Field Report cannot be configured as Exception reports.

Refer to the next chapter on Advanced Reporting Topics for more details on Formatted Field Reports.
Creating a New Report
To create a new Report in Pangaea, select the Site or Folder in the site tree where you want it to be created and:

- Select ADD→REPORT; or
- Select NEW REPORT in the Hints Panel.

After you have created the new Report, double-click on it, or select it and click OPEN THIS REPORT in the hints panel to open and configure it. You will be presented with a form which contains several areas for configuring the report:

- The upper-right area has controls for setting the Report Properties and running the reports. Refer to the later sub-section on Report Properties and the later section on Running the Report.
- As in Excel, a report is made up of a set of Report Tabs. The REPORT TABS list on the right side shows the list of tabs in the reports. Refer to the later section on Report Tabs.
- Each Report Tab consists of a set of Report Tab Columns, each of which corresponds to a point collected by a data collector (or a calculation of other points). The REPORT TAB COLUMNS list in the lower right area of the form shows the list of columns for the selected tab. Refer to the later section on Report Tabs and Columns.
- The left side of the form has controls for navigating through the points in the site and adding them as columns to a report tab. Refer to the later section on Report Tabs and Columns.
Each row in a generated tab represents a single point in time. The timestamp appears in the first column, and each data column shows the value of that point at that time.

Here is a sample report which includes four tabs:

Here is the same report generated to Excel:
In this example there are four tabs defined: HWS, RTU1, RTU2 and Rm1201. The Rm1201 tab has five point columns. The definition of the report looks like this:

![Report Definition]

**Report Properties**

This region displays and allows you to configure the basic properties and defaults for the entire report, including the *Title*, *Date Range* and *Charting Options*:
Click on the MORE OPTION button for a few additional options:

As noted below, some of these options can be overridden on a per-tab by right-clicking on a tab in the list and selecting EDIT TAB PROPERTIES.

**Date Range**
The *Date Range* setting allows you to choose the time span of the data to report. You can choose from the most recent number of days, weeks or months, the month or year to date, or a specific start and end date.

**Charting Options**
You can choose to include a graphical chart of your data to go along with (or replace) the tabular data.

- The default (Only Display Table) is to not include a chart
- If you include charts, you can include them same tabs as the tables or on separate tabs.
• You can override the charting option for each tab by right-clicking on a tab in the list and selecting **Edit Tab Properties**.

**Report Style**
As described earlier in this chapter, there are three basic types of reports. The Report Style settings help define these types. Refer to the next chapter for more details on Schedule Reports and Formatted Field Reports.

**Tabs and Columns, one row for each timestamp**
This is the option for a standard *Trend Report* as well as a *Formatted Field Report*.

**Rows and Cells, each cell is latest value of point**
This is the option for a *Schedule Report*. When this option is selected, you can also choose between a Normal and Exception report.

![Edit Report Properties](image)

**Minimum Timestamp Difference**
As discussed in the later section on *Running the Report*, each row in the report will represent a single timestamp and the values of all the points at that time. If all the points in the report were collected at the exact same interval (e.g., 12:15:00, 12:30:00, 12:45:00, etc.) then the corresponding values from each point will easily match.

However, depending on the data source, some points may be collected at slightly different times. For example, if the second column’s values were collected at 2 seconds after the :15 interval (e.g. 12:15:02, 12:30:02, etc.), then each value would be skewed and the 12:15:02 value would end up corresponding to the first column’s 12:30:00 timestamp. The **Minimum Timestamp Difference** sets the number of seconds after the row’s timestamp that a value should still be matched to the row. Therefore, with the default 5 second setting, values from 12:00:06 to 12:15:05 would match to the 12:15:00 row.
Add rows for each change of Boolean Values

The rows in the report each represent a single timestamp. The list of timestamps (and therefore rows) is generally based on the first numeric column in the report, as they are normally collected at a regular interval. Other columns’ values are matched up with the first column’s timestamps.

However, Boolean points are often collected as a Change of State value, meaning a record is created every time the value goes from True to False or False to True and the timestamp recorded is the exact moment that the transition occurred. When matched up to the interval timestamps, the column will display the Boolean point’s value at the interval’s timestamp. It will not, however, show the time of the Boolean point’s transition. Also, if the value changed from False to True then back to False within the interval, there will be no indication of this in the report.

In this example, we can tell that the Fan Status changed from OFF to ON between 12:15 and 12:30, but not exactly when (or if it went on, then off, then on again).

To adjust this, you can tell the report to add a new row to the report every time any Boolean value changes. With this on, the report would look like:

Notice the additional row with the 12:17:21 timestamp indicating the moment the Fan Status changed from OFF to ON.

You can also get any individual column to add its rows as part of the Column Properties, described later in this chapter.
Report Tabs

You can add a tab to the report by clicking the ADD TAB button under the Report Tabs list. Doing so will bring up the *Edit Tab Properties* form:

- You can edit these tab properties at any time double-clicking the tab in the tab list or right-clicking the tab and selecting *Edit Tab Properties*.

You will want to specify the title of the tab, but most of the options can be left with their default values until you need to change them.

- The *Report Type* can be set to *Aggregate* or *Exception*, as described in later sections.
The **Minimum Timestamp Difference** allows you to override the value of this property set as set in the Report Properties. Refer to the earlier section for more information.

- The **Aggregate Options** are used with Aggregate reports.

- If you want to add additional rows to the end of the report with statistical values, such as averages, minimums and maximums, check the appropriate boxes. These values are only displayed when you generate the rows to Excel.

- The **Report Template** allows you to use a custom Excel file as the basis of the Excel version of the report. Refer to the section on *Custom Excel Templates* in the next chapter, *Advanced Reporting Topics*.

- The **Charting** options allow you to override the charting options specified in the Report properties, and allow you to control the type of chart created (e.g., *Line Chart, Bar Chart, Column Chart*, etc.)

You can change the order of the tabs by selecting a tab in the list and using the Up and Down arrows.

**Report Columns**

For the most part you create columns in your reports by browsing through your data collectors and selecting points to display. You can also add *Calculated* and *Exception* columns (as described in the next chapter).

**Selecting a Data Collector and Adding Points as Columns**

The left side of the form has controls for helping you find the points you need:
First, select the Data Collector that was used to create the point or points you want.

- Points from all the Manual Data Collectors are listed as the Data Collector named *Manual Points*.

The drop-down list shows all the Data Collectors alphabetically by name. You can also select the Data Collector from the Pangaea site’s tree by clicking the MORE (…) button to the right of the list:

Once you select the Data Collector, the list of points that were created and collected by that Data Collector will be shown. You can view the points in two ways:

- The *Tree View* shows the points using the hierarchy from the Data Collector. For the more detailed Data Collectors, such as those for the Tridium Niagara systems, this is the more natural way to view and find the points.
- The *List View* shows the same list of points, but in a grid format. This format includes more information, such as Column Heading, Format and Descriptions. It also allows for multiple selection of individual points (by holding SHIFT or CONTROL while clicking), which cannot be done in the Tree View.
In either view, select the point or points you want to add to the report and click the blue arrow button to add them.

- In the Tree View, selecting a folder and clicking the arrow will add multiple points and automatically create tabs, as described later in this section.

**Column Properties**

To edit the properties of a column, double-click it in the Report Tab Columns list or right-click the tab and select **EDIT COLUMN PROPERTIES**.

- The *Column Heading* is displayed at the top of the report column. If left blank, the Point Name is used instead.
- As described in the later section on *Running the Report*, you can instruct the report to add a new row to the report any time the timestamps of this column do not correspond to those in the first column. This is normally for cases where the point data is recorded when it changes (such as with Booleans), and not at regular intervals.
- For columns used only in calculations, you may want to turn off the *Visible* checkbox. This will prevent the column from being created in the report tab.
- There are other properties used only in Aggregate reports, as described in the next chapter.
The format of the values is, by default, taken from the properties of the point itself. If the point was not formatted, or you want to override the format, click the **EDIT FORMAT** button:

![Edit Column Format](image)

**Viewing and Editing Point Information and Values**

As with most other features of Pangaea that lists points or shows them in a tree view, you can right-click on a point name (in the Point Selector on the left or the Report Tab Columns list on the right) to bring up a menu of commands:

![Tree View](image)

Refer to the earlier chapter *Data Points* for more details.

**Creating Tabs Automatically from Data Collector Folders**

While in the Tree View of a Data Collector, you can quickly add entire folders of points to the report. This makes it very simple to create an entire workbook of report tabs using the existing programming structure of sophisticated data sources such as Niagara.
When you select a folder in the Data Collector’s TreeView, the text next to the blue ADD arrow will indicate how the points within the folder will be added.

In this case, clicking the arrow button creates a new tab and adds all the points as columns:
**Add Folder Options**

There are several options when adding folders, the controls for which are below the Data Collector’s point list:

![Point Adding Properties](image)

There are three options for how points are added and tabs created:

**Add Points to Current Tab**

All the points in the folder, and all its sub-folders, are added to the currently selected tab.

**Create One New Tab for All Points**

A single new tab is created, and all the points in the folder and all its sub-folders are added to it.

**Create Separate Tabs for Each Folder**

Each folder becomes its own tab, and all the points directly within the folder are added. If the folder has sub-folders, each becomes its own tab.

**Tab Naming**

There are three options for setting the name of new tabs as they are created.

**Folder Name**

This will simply use the name of the folder being created as a tab,

**Parent Folder Name**

This will use the name of the parent of the folder being created as a tab. This would be used in cases where every logic folder in the data source contains a similarly named folder such as “Logs” or “Points” where the trend logs are located.

**Combine Parent and Folder Name**

This will use the combined name of the folder’s parent as well as the folder itself. This can help disambiguate cases where different folders (e.g. “Bldg A” and “Bldg B”) contain similarly named children (“AHUs”, “RTUs”).

Here is an example of the Combine Parent and Folder Name option:
Column Naming

There are also three options for how the columns will be named, each specifying a different property of the point: Column Heading, Name or Description.

- Each point has a Name, but the Description is usually brought it from a data source such as Niagara.
- The Column Heading is usually only set manually.
- If you select Description or Column Heading and the value is blank, the Name will be used.

Running the Report

You can run the report at any time by clicking the Run Report button. You can choose to generate the report to the screen or to a new Excel Workbook.

- You must have Microsoft Excel installed to generate Excel reports.
- Some features of the report, such as adding statistics reports to the bottom of a report (available by editing the Tab Properties) or using an existing Excel file as a template for the generated report, are ignored when generating the report to the screen.

You can also create a report from a single tab:
Right-click on the tab and select **RUN REPORT TAB.**

![Report Tabs](image)

To generate the report on a scheduled basis, refer to the later section on *Transport Settings* and the later chapter on *Task Scheduling.*

You can also run an entire report directly from the Site tree when you are not editing the report.

- Right-click on the report in the site tree and select **RUN REPORT;** or
- Select the report in the site tree and click **RUN THIS REPORT** in the Hints Panel.

When you run the report this way, the Excel version is automatically selected and the resulting workbook is emailed or copied based on the Delivery Options, as described in the later section on *Scheduling and Delivering the Report.*

**The Report Timestamp Algorithm**

When reporting a set of points from the same source, the values are often aligned and require no special considerations to make the data accurate. However, if the data is from different sources the timestamps of the values may not align as you expect. In these cases it may help to understand exactly how Pangaea generates its reports and aligns values, and what options are available to control the algorithm.

**Determining the Timestamps for the Rows**

Each row in a report contains a single timestamp. The list of timestamps that make up the rows in a report tab are taken from the *first column of Double values.* If no Double columns exist, the first column’s timestamps are used regardless of its data type.
Finding the Closest Value in Each Column for Each Row’s Timestamp
For each row in the report, Pangaea looks in each column of data to determine the value to show in that column’s cell.

- If the column contains a timestamp that matches, the value for that timestamp is used.
- If the column contains a timestamp that is a little bit ahead of the row’s timestamp, it is used. The number of seconds of look ahead is specified by the report’s Minimum Timestamp Difference setting (refer to the earlier section on Report Properties), and can be overridden on a per-tab basis in the tab’s properties (refer to the earlier section on Report Tabs). The default for this setting is 5 seconds.
- If there is no match within the look ahead time, Pangaea finds the most recent value that is earlier than the row’s timestamp.

Adding Rows for Change of State Columns
Whereas Double values are often recorded at regular intervals, Boolean values (and sometimes Multistate values) can be more efficiently stored based on Change of State. In these cases, the timestamps of the point’s values will likely not align with those from the Double columns.

- By default, the rules from the last section will cause the value in the cell to be the value based on the last change of state, and so will accurately reflect the value of the Boolean value at the row’s timestamp.

However, there can be two cases where this is not sufficient.

- You may want to know the exact moment that the value changed.
- You need to be sure that value didn’t change twice or more in the interval. If a value goes from False to True and back to False in the interval, there would be no record of it in the report.

To handle these cases, you can tell Pangaea to add a new row to the report every time the value changes. This can be done in two ways:

- To add these additional rows for all Boolean columns in all the tabs in a report, check the Add Rows for Each Change of Boolean Values option in the Report Properties.
• You can force individual columns of any data type to create new rows based on their timestamps by editing the Column Properties and checking the ADD NEW ROWS FOR EACH DIFFERENT TIMESTAMP IN THIS COLUMN option.

Scheduling and Delivering the Report
Once you’ve designed the report, you can have Pangaea run it automatically on a regular basis and deliver the results (as an Excel workbook) by various means.

Scheduling a Report
To set the report schedule:

• If you are editing the report, close it.
• Right-click on the Report node in the Pangaea Site tree and select SET REPORT SCHEDULE.

There are a number of options, which are detailed in the later chapter on Task Scheduling. Here is an example of scheduling a report to run every Monday morning at 3 am:

• Check the SCHEDULE THIS TASK checkbox.
- Set the SCHEDULE TYPE to **Recurrence**.
- Choose the Weekly RECURRENCE PATTERN and select **MONDAY**.

Refer to the later chapter on *Task Scheduling* for more details.

**Setting the Delivery Options**

When the report is run from a schedule, you can configure the generated Excel workbook to be emailed, saved to a local or network drive, or uploaded to an FTP server.

To set the report delivery options:

- If you are editing the report, close it.
- Right-click on the Report node in the Pangaea Site tree and select **EDIT DELIVERY PROPERTIES**.

![Report Delivery Options](image)

**Report Delivery Options**

- **Email**
  - Attachment File Name:
  - Include Date In File Name
  - Include Time In File Name
  - E-Mail File To:
  - Email From:
  - Email Subject: Report:
  - Email Body: Pangaea Report

- **Save to This Computer or Local Network**
  - Save Folder:
  - File Name:
  - Compress File
  - Retain Multiple Copies Of File: For 7 Days

- **Send to FTP Site**
  - FTP Address:
  - User ID:
  - Password:
  - Save Folder:
  - File Name:
  - Compress File
  - Retain Multiple Copies Of File: For 7 Days

**OK**  **Cancel**
• Check the types of delivery you want and fill in the parameters. The various options are described in the next sections.

• When a heading appears in red, there are parameters that are incorrect or missing.

To test your delivery settings, run the report from the Site Tree as described in the earlier section Running the Report. The Excel workbook will be generated and sent according to the delivery options.

**Emailing the Report**

When you email the report, an email is sent with the Excel file as an attachment.

- To have the file compressed into a zip file before attaching, check the COMPRESS FILE option. This may be important for bigger reports as it reaches the attachments size limits imposed by the email service.
- If you want to have the attachment file name to include a timestamp, check INCLUDE DATE IN FILE NAME. If the report is generated more than once a day, you should also check the INCLUDE TIME IN FILE NAME option.
- The EMAIL FROM must be set to a valid email address format, but the email address does not necessarily need to exist. If the EMAIL FROM address is not valid, you may want to ensure that the recipient know they should not try to respond to the email.

*Note: To send email the workstation or server will need access to an SMTP server. This type of server is usually set up by an organization’s IT department, or made available from an Internet Service Provider (ISP). It is also possible to use an internet mail account, such as those from Gmail, Yahoo or Verizon, to act as an SMTP server.*

*Refer to the later chapter on Configuring Pangaea for Sending Email.*
Saving the Report to a Local or Network Folder
You can instruct Pangaea to save the Excel workbook to a local or network folder:

- To have the file compressed into a zip file, check the COMPRESS FILE option

By default the file will be overwritten each time it is generated. If you want to keep multiple versions of the file, check RETAIN MULTIPLE COPIES OF FILE and choose an option for the number of versions to keep (Days, Versions, or Forever).

- The name of the saved file will automatically include a timestamp to ensure the file names are unique.
- Versions of the file that are older than the number of Days or Versions specified will automatically be deleted.

Uploading the Report to an FTP Site
You can also have the Excel workbook copied to an FTP site.

- To have the file compressed into a zip file, check the COMPRESS FILE option
By default the file will be overwritten each time it is generated. If you want to keep multiple versions of the file, check RETAIN MULTIPLE COPIES OF FILE and choose an option for the number of versions to keep (Days, Versions, or Forever).

- The name of the saved file will automatically include a timestamp to ensure the file names are unique.
- Versions of the file that are older than the number of Days or Versions specified will automatically be deleted from the FTP site.
11. Advanced Reporting Topics

Pangaea’s reporting has a number of advanced options that you can use to create more powerful or flexible reports. These advanced topics include:

- Schedule Reports
- Formatted Field Reports
- Calculated Columns
- Exception Reports
- Aggregate Reports
- Using Excel Templates
- Copying and Pasting Report Layouts

You will want to review the previous chapter, Reports, before reading this chapter.

Schedule Reports

Schedule Reports are designed to show a snapshot of the status and health of multiple systems in a single report. One common example is a set of VAV systems, which are often engineered as a single system and duplicated within the control system, and so have the same named points in each instance of the control system.
In comparison to a Trend Report:

- Where Trend Reports allow you to build up multiple *tabs* of points to display, Schedule Reports let you build up multiple *rows*.
- Where Trend Reports consider each point to be a *column*, Schedule Reports treat each point as a *cell*.
- Each point is still a column of the report, but only the first row is used to define the column headings in all rows.
- In each row, the points selected are assumed to align with the points selected in the first row. It is possible to have empty cells in cases where not every system has every point.
- There will only be a single tab in the output of a Schedule Report.

**Creating a Schedule Report**
To create a Schedule Report, create a new Report node and configure it as follows:

- Click the MORE OPTIONS button under Report Properties and choose the *Rows and Cells* option.
• The Report Tabs and Report Tab Columns lists will be shown as Report Rows and Report Cell Values.

<table>
<thead>
<tr>
<th>Report Rows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row Name</td>
</tr>
<tr>
<td>VAV 1</td>
</tr>
<tr>
<td>VAV 2</td>
</tr>
<tr>
<td>VAV 3</td>
</tr>
<tr>
<td>VAV 4</td>
</tr>
<tr>
<td>VAV 5</td>
</tr>
<tr>
<td>VAV 6</td>
</tr>
<tr>
<td>VAV 7</td>
</tr>
<tr>
<td>VAV 8</td>
</tr>
<tr>
<td>VAV 9</td>
</tr>
<tr>
<td>Rows: 9</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Report Cell Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Heading</td>
</tr>
<tr>
<td>A</td>
</tr>
<tr>
<td>B</td>
</tr>
<tr>
<td>C</td>
</tr>
<tr>
<td>D</td>
</tr>
<tr>
<td>E</td>
</tr>
<tr>
<td>F</td>
</tr>
<tr>
<td>G</td>
</tr>
</tbody>
</table>

• Select the points for the first row as described in the previous chapter. The first row will be a template for all the subsequent rows.
• Add additional rows as you would have added additional tabs in a Trend Report. Select the points in an order that aligns them with the columns defined in the first row.
• If you want to leave a cell blank, create a Calculated Cell and leave the formula blank.
Formatted Field Reports

Formatted Field Reports are used in cases where you need to fill data into an existing form (e.g. a state-specified LEED Energy report) or a custom layout.

In comparison to a Trend Report:

- Where Trend Reports treat each point as a column, Formatted Field Reports treat each point (or calculated value) as a field.
  - The Fields in a Formatted Field Report can include more sophisticated aggregate functions that allow you to extract individual monthly usage from a point with accumulated meter data.
- Formatted Field Reports require an Excel template to be used.
Creating a Formatted Field Report
To create a report tab a Formatted Report, right-click the tab and choose the REPORT TYPE of Field.

- Click the MANAGE TEMPLATES button to upload the Excel workbook file containing the template for the report into your site. Refer to the later section on Using Excel Templates for more details. Once uploaded, select the template from the list.

The Report Tab Columns list will be relabeled as Report Tab Fields.

- Select the points to use as the field values as you would columns in a Trend Report. The fields will be labeled A, B, C (etc.) as the columns were. These will be used for the field names in the report template (<A#>, <B#>, <C#>, etc.)
**Field Aggregations**

To create a field that is an aggregation of the values in a point, double-click the field in the list or right-click on the field and select EDIT FIELD PROPERTIES.

First, choose an aggregation function:

- Check the AGGREGATE POINT DATA checkbox
- Select the AGGREGATE FUNCTION.
  - For meter values, the Change in Value options can be used to calculate the difference between the first (or last) readings in a month to yield the usage for the month.

Next, determine how to calculate the range of dates to use for this aggregation. There are two options:
• **Select Calculate Date Range Relative to Now**
  o When selected, the various combinations of *Date Range, Begin Range* and *End Range* can be used to customize the range in such a way that it adjusts relative to the current date.

• **Calculate Date Range Using Formulas**
  o For even more control, you can create a formula to determine the date range based on the date selected by the user when the report is run.
  o Use the pre-defined value *BaseDate* in your formulas to reference the selected start date for the report.
  o Refer to the later section or *Calculated Columns* for more details on calculations and custom formulas.

**Changing the Point Assigned to One or More Fields**
You may find cases where you have a report that you want to reuse, but it contains many columns that reference the same specific point from a different data collector. In these cases, you can easily reassign the point associated with the fields.

• In the Point Selector panel, select the appropriate Data Collector and Point.
• In the Report Tab Fields list, select one or more fields that you want the point assigned to.
• Right-click and select **ASSIGN POINT POINTNAME TO SELECTED COLUMNS**

**Calculated Columns and Fields**
Pangaea allows you to add additional columns and fields to your reports with values calculated from other columns, fields or points. The types of calculations are similar to formulas found in Excel.

• To add a calculated column to a report tab, click the **ADD CALCULATED COLUMN** (or **ADD CALCULATED FIELD**) button under the Report Tab Columns list.
For Trend Report, you will be shown the Column Properties:

- You enter the **FORMULA** as a mathematical expression using the values from other columns in the report.
- The other columns are referenced by their Column Letter (A, B, C, etc.), shown in the column list.
- You need to set the **DATA TYPE** to the appropriate result type.
- To format the resulting value, such as with units, click **EDIT FORMAT**.

When you run the report, the value for each row’s cell in the calculated column will be calculated based on the formula and the values for the referenced columns in that row.
As shown in the example, you create expressions using the column letters and standard formula operators, such as:

\[
\begin{align*}
A + B \\
(C + D) / (E + 5) \\
A > (B - C) \\
(A > B) \text{ And } (C < D)
\end{align*}
\]

- As you enter the formula, an indicator of OK or ERROR will appear to indicate that the syntax of the formula is correct.
- The formulas can use any of the available data types, including Double, Binary, String, Date and Multistate.
- Depending on the formula and functions, the result of the formula can also be any type. You must explicitly specify the expected result. If the actual resulting type differs from the specified type, the value will be converted as best as it can.
- You can use a calculated column as part of another calculated column. For more complicated formulas, it may help to break up the expression into a series of smaller expressions then combine the results of those into the final expression. If you don’t want these intermediate values displayed in your report, simply edit their properties (right-click, EDIT COLUMN PROPERTIES) and turn off the Visible option.

You should not reference a column that comes after the one being calculated (i.e., don’t use the expression D+A in column C). If you do, the values for that column will be empty (i.e. 0 or False). You can reorder the columns as necessary using the up and down arrows. As you rearrange the columns, all the references to the columns in the formulas will update accordingly, just as they do in Microsoft Excel.

For a comprehensive explanation of Smartware’s Expression Language, please see the Smartware Expression Language reference guide, available from the HELP Menu.

**Exception Reports**

There are times when you may want to create a report that checks for certain abnormal situations, otherwise known as alarm, error or exception conditions. Pangaea has a special type of report, Exception Reports, designed for these cases.

The basic steps are:

- Create a report tab that includes calculations that result in a Binary value that indicates an exception. They could be references to point columns that are already alarms in the source system, or calculations such as \( A > 78 \) (if say, \( A \) was a temperature) or \( B > C + 2 \) (if \( B \) was a temperature and \( C \) was a set point).
- Configure the report to be emailed to the appropriate people who would need to know about the exception.
- Schedule the report to run as frequently as you want the condition checked (or as often as the data values are updated).

When the Exception Report is run, if there are no data rows where any of the exceptions occurred, the report will be empty and Pangaea will not send the email. In that case, you can have Pangaea run the report every hour (or less, even) and know that when an exception occurs it will be reported timely.

**Creating an Exception Report**
There are two steps to defining a report as an Exception Report.

**Change the report tab’s Report Type to Exception**
Double-click the report tab or right-click the report tab in the list and select Edit Tab Properties:

- Change the Report Type to *Exception*
Create Exception Columns

Exception Columns are essentially Calculated Columns that return a Binary value (True or False), where the True value indicates the exception. For more information on Calculated Columns, refer to the previous section.

- To create an Exception Column, click the ADD EXCEPTION COLUMN beneath the column list instead of ADD CALCULATED COLUMN.

- The Data Type will be fixed as Binary.

Enter the formula for the Exception condition.

- If there is already a point columns indicating the error, the formula would be simply that column letter (e.g. “A”).
- To compare a point value to a specific limit, use a formula such as A > 72.
- To compare two values, use comparison between them. If column B were a temperature and C was the expected value (setpoint), you could check to see that the value was within 2 degrees of the set point with the formula (B >= C-2) And (B <= C+2).
- Refer to the previous section on Calculated Columns for a full reference of the formula syntax and functions.

You may also want to give more descriptive names to the values other than True and False, such as ERROR and OK, or Too High and Normal. Click the EDIT FORMAT button to specify these values.
Aggregate Report Tabs

*Aggregate Reports Tabs*, sometimes called *Rollup Reports*, can be used to group multiple records together to calculate averages, sums, or other functions over specific intervals of time.

- Aggregate report periods can be hourly, daily, weekly, or monthly.
- You can mix Aggregate Report tabs with regular report tabs.

When an Aggregate Report is run, the resulting report will display one row for each period which represents the function applied to all the actual records in that time span. For example, for a point which had data collected every 15 minutes, there would be four records per hour. In an hourly aggregate report, we would have one record for each hour showing the average (or sum, etc.) of the four records during that time period. The timestamp will be the time at the start of the hour.

**Creating an Aggregate Report Tab**

To define a report tab as an Aggregate Report:

- Double-click the report tab or right-click the report tab in the list and select **Edit Tab Properties**:

![Edit Tab Properties](image)

- Change the **Report Type** to *Aggregate*.
- Select the **Aggregation Period** (*Hourly, Daily, Weekly* or *Monthly*).
- If the Aggregation Period is *Weekly*, specify the **First Day Of Week**.
You can also choose two other options:

- To have the name of the Aggregation Function automatically appended to the name of the column (e.g., “Water Usage (Sum)” or “Room Temp (Avg)”), check the **INCLUDE AGGREGATE FUNCTION NAME IN COLUMN HEADINGS** option.
- The report will limit itself to the range of data available. To “round out” these values and extend the report to show all the hours of the day, all days of the week, all days of the month, or all months of the year (based on the Aggregation Period), check the **INCLUDE AGGREGATE PERIODS WITH NO DATA**.

**Specifying Aggregate Functions**

When a report tab, each column can define the function that is applied to the values grouped together for each aggregate period.

- The default **Aggregation Function** is **Average**.

To specify a different function, double-click the column or right-click it and select **EDIT COLUMN PROPERTIES**.

![Edit Column Properties](image)

Each function is applied to all the records in an aggregate period. For example, if the values are recorded every fifteen minutes and the report is aggregated as hourly, there will be four records per period.

The **Aggregate Functions** are:

- **Min** Returns the lowest value during the period
- **Max** Returns the highest value during the period
- **Sum** Returns the sum of all values for the period
Average Returns the average (mathematical mean, or the sum of the values divided by the number of records) of the values for the period

First Returns the value associated with the record with the earliest timestamp for the period.

Last Returns the value associated with the record with the latest timestamp for the period.

Timestamp of Min Returns the timestamp of the record with the lowest value during the period.

Timestamp of Max Returns the timestamp of the record with the highest value during the period.

Difference Returns the difference between the first record value in the period and the first record value in the previous period.

Here is an example of a report of two temperature columns aggregated on an hourly basis:

- If calculated columns are used in the report, the calculation is applied on a row by row basis to the aggregated values.

Using Excel Templates
If you want to customize the output of an Excel-generated report, you can define your own templates using Excel and have Pangaea use that template when running one or more tabs.
For example, here is the default Excel output of a simple EM-08 report:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Date and Time</td>
<td>Room Temp</td>
<td>Humidity</td>
<td>Illumination</td>
</tr>
<tr>
<td>2</td>
<td>07/15/2013 01:00:00 PM</td>
<td>76.2 °F</td>
<td>58.6 %</td>
<td>6.4 lx</td>
</tr>
<tr>
<td>3</td>
<td>07/15/2013 01:15:00 PM</td>
<td>75.9 °F</td>
<td>58.2 %</td>
<td>19.2 lx</td>
</tr>
<tr>
<td>4</td>
<td>07/15/2013 01:30:00 PM</td>
<td>75.9 °F</td>
<td>58.2 %</td>
<td>26.3 lx</td>
</tr>
<tr>
<td>5</td>
<td>07/15/2013 01:45:00 PM</td>
<td>76.2 °F</td>
<td>56.6 %</td>
<td>9.6 lx</td>
</tr>
<tr>
<td>6</td>
<td>07/15/2013 02:00:00 PM</td>
<td>76.1 °F</td>
<td>56.7 %</td>
<td>9.6 lx</td>
</tr>
<tr>
<td>7</td>
<td>07/15/2013 02:15:00 PM</td>
<td>76.1 °F</td>
<td>56.7 %</td>
<td>9.6 lx</td>
</tr>
<tr>
<td>8</td>
<td>07/15/2013 02:30:00 PM</td>
<td>76.2 °F</td>
<td>56.7 %</td>
<td>9.6 lx</td>
</tr>
<tr>
<td>9</td>
<td>07/15/2013 02:45:00 PM</td>
<td>76.2 °F</td>
<td>56.7 %</td>
<td>9.6 lx</td>
</tr>
</tbody>
</table>

You can create a custom Excel file to use as a template instead. For example, consider the following:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>&lt;I&gt;</td>
<td>EM-08 Data Readings</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>&lt;I&gt;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>&lt;I&gt;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>&lt;I&gt;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Reading Time</td>
<td>Room Temp</td>
<td>Humidity</td>
<td>Illumination</td>
<td>Condition</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>&lt;TimeStamp&gt;</td>
<td>&lt;A$&gt;</td>
<td>&lt;B$&gt;</td>
<td>&lt;C$&gt;</td>
<td>&lt;D$&gt;</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>&lt;F&gt;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Using this template, the generated report tab would instead look like:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EM-08 Data Readings</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Reading Time</td>
<td>Room Temp</td>
<td>Humidity</td>
<td>Illumination</td>
<td>Condition</td>
</tr>
<tr>
<td>6</td>
<td>7/15/13 1:00 PM</td>
<td>76.2 °F</td>
<td>58.60%</td>
<td>6.4 lx</td>
<td>OK</td>
</tr>
<tr>
<td>7</td>
<td>7/15/13 1:15 PM</td>
<td>75.9 °F</td>
<td>58.20%</td>
<td>19.2 lx</td>
<td>OK</td>
</tr>
<tr>
<td>8</td>
<td>7/15/13 1:30 PM</td>
<td>75.9 °F</td>
<td>58.20%</td>
<td>26.3 lx</td>
<td>OK</td>
</tr>
<tr>
<td>9</td>
<td>7/15/13 1:45 PM</td>
<td>76.2 °F</td>
<td>56.60%</td>
<td>9.6 lx</td>
<td>OK</td>
</tr>
<tr>
<td>10</td>
<td>7/15/13 2:00 PM</td>
<td>76.1 °F</td>
<td>56.70%</td>
<td>9.6 lx</td>
<td>OK</td>
</tr>
<tr>
<td>11</td>
<td>7/15/13 2:15 PM</td>
<td>76.1 °F</td>
<td>56.70%</td>
<td>9.6 lx</td>
<td>OK</td>
</tr>
<tr>
<td>12</td>
<td>7/15/13 2:30 PM</td>
<td>76.2 °F</td>
<td>56.70%</td>
<td>9.6 lx</td>
<td>OK</td>
</tr>
<tr>
<td>13</td>
<td>7/15/13 2:45 PM</td>
<td>76.2 °F</td>
<td>56.70%</td>
<td>9.6 lx</td>
<td>OK</td>
</tr>
</tbody>
</table>
Creating a Custom Excel Template

A Custom Excel Template is just a regular Excel file with a few special codes and formats to tell Pangaea where to plug in the generated report data.

Reviewing our previous example:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>&lt;H&gt;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>&lt;D&gt;</td>
<td>&lt;TimeStamp&gt;</td>
<td>&lt;A$&gt;</td>
<td>&lt;B$&gt;</td>
<td>&lt;C$&gt;</td>
<td>&lt;D$&gt;</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

EM-08 Data Readings

The first column of the template tells Pangaea where the three sections of the report are defined:

- Add a new column A to the report. Put “<H>” in cell A1 to indicate where the heading section begins. You will likely want the columns headings to be in the last row of the heading section (e.g., Row 5 in the above example)
- Add “<D>” to the appropriate cell in the first column to indicate where the data section begins. This is cell A6 in the example
- Add “<F>” to the appropriate cell in the first column to indicate where the footer section begins. This is usually the row right after the data row (cell A7 in the example).

When the report is run, the template worksheet is copied into the output workbook and the data row is filled in and repeated for each data record in the report.

In the data row, you add field codes that correspond to the report columns.

- Use the code “<TimeStamp>” for the timestamp value for the row
- Add codes labeled “<A$>”, “<B$>”, “<C$>”, etc. to insert the formatted value for each row into the spreadsheet when the report is run. The formatted value will contain unit suffixes (e.g., “°F”) and Binary value display text (e.g., “OPEN” and “CLOSE”) as defined in the points or report columns. These are better for reports that are just being viewed.
- Alternatively, you can use codes labeled “<A#>”, “<B#>”, “<C#>” to have the raw values (just the numeric values, or for Binary values, TRUE and FALSE) used. These are better for reports where you need to manipulate the values that are generated in other Excel formulas, sorting or subtotaling.
If you do use the unformatted values (<A#> instead of <A$>), you can still control the format of the output by formatting the cell in the template. For example, if we used <A#> for the temperature column, you can add a custom format for cell C6:

![Image of Excel template with formatted cells]

You can use any types of fonts, colors, styles, images and other Excel features within the report, including Excel formulas.

- Use this technique to format the <TimeStamp> column with custom date formats.

**Selecting a Template for a Report**

After creating the template, you can specify that it should be used for individual report tabs by edit the report tab’s properties and selecting the template file:
• Select the MANAGE TEMPLATES button to display the Report Template Manager.

![Report Template Manager](image)

• Click the ADD button to browse to the Excel file on your local computer.

![Edit Report Template](image)

• The file will be imported and stored in the Pangaea database so it can be used from any computer accessing that site database.
• Once uploaded, you can select it for other report tabs in the same Pangaea site.
• To extract the file and view it in Excel, click the PREVIEW button.
• You can also choose a web-based URL for the file, assuming it's stored on an accessible web server.
**Editing a Report Template**

If you need to modify an Excel Template after you have uploaded it, you will need to modify it in Excel and re-upload it into the site database. Pangaea will **not** notice any changes you make to the original file from your hard drive.

- From the Report Template Manager, select the template and click **EDIT**.
- If you have the original file, modify it in Excel. If necessary, use the **PREVIEW** button to extract a new copy of the existing template.
- Browse to the updated file and upload it again.
- Any changes you make to the template will affect all reports and tabs that referenced the original.
Copying and Pasting Report Layouts

As shown earlier, Pangaea makes it easy to create multiple report tabs at the same time based on the folder structure of the original Data Collector.

Consider this sample Data Collector:

- Because we’re using the Create Separate Tabs for Each Folder option, clicking the ADD button will add five separate report tabs, one for each of the child folders in the Boilers node.
- Because we have the Parent Folder Name option selected, the names of the report tabs will be Boiler_1, Boiler_2, etc. Had we not chosen this option, and used the default Folder Name option, all the tabs would be named Logs_Alarm.
So adding the five tabs gives us:

<table>
<thead>
<tr>
<th>Report Tabs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
</tr>
<tr>
<td>Boiler_1</td>
</tr>
<tr>
<td>Boiler_2</td>
</tr>
<tr>
<td>Boiler_3</td>
</tr>
<tr>
<td>Boiler_4</td>
</tr>
<tr>
<td>System</td>
</tr>
</tbody>
</table>

Tabs: 5

<table>
<thead>
<tr>
<th>Report Tab Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Heading</td>
</tr>
<tr>
<td>A</td>
</tr>
<tr>
<td>B</td>
</tr>
<tr>
<td>C</td>
</tr>
<tr>
<td>D</td>
</tr>
<tr>
<td>E</td>
</tr>
<tr>
<td>F</td>
</tr>
<tr>
<td>G</td>
</tr>
<tr>
<td>H</td>
</tr>
<tr>
<td>I</td>
</tr>
</tbody>
</table>

While this is a quick way to create the tabs, if we need to change parts of the layout of the tab we would have to make the changes to each tab separately. Such changes would be:

- The order of the columns
- The Column properties, such as Column Header, Format, Insert Timestamps and Visible.
- The Report Tab properties, including Minimum Timestamp Difference, Rows to Add to Bottom of Excel Report (Sum, Average, etc.), and Excel Template Name.
Pangaea has a simple method to handle these cases:

- First, modify one of the similar tabs and set the column order, column headings and tab properties.

  - In this case we renamed three of the columns, reordered those three, and made a fourth one invisible.

- Right-click on this customized tab and select COPY REPORT LAYOUT. This essentially puts the tab’s layout on the clipboard.

- Select the one or more of the other tabs that have a similar list of point names (hold down SHIFT or CTRL to multi-select).

- Right-click on the selected tabs and select APPLY REPORT LAYOUT.

The Apply Report Layout feature will do the following to each tab:

- Using the copied tab as a guide, it reorders the columns based on any matching Point Names and sets the column properties. Any other columns that were in the second tab but not in the first are left in the second tab, but are located after all the matching columns.

- All other Tab Properties are copied into the new tab.
12. Task Scheduling

Pangaea has an integrated Task Scheduler which allows you to schedule the automatic collection of data and execution of reports on a regular basis.

- Data Collectors that read live values of devices, such as Web Sensors, will usually be scheduled to read and collect data on a small interval, such as every 15 minutes.
- Data Collectors for devices that themselves archive data from logs or histories, such as Niagara systems, will usually be scheduled to update once a day, often right before generating a report.
- Reports are often scheduled to be run and emailed on a nightly or weekly basis.

The Task Schedule runs as its own Pangaea Windows Service, which is installed and configured through the Pangaea application. It does not use the Windows Task Scheduler, which has been shown to be unreliable when a workstation is locked or logged out.

Note: In previous versions of Pangaea, the Task Schedule was run by putting the Pangaea application in the Run Scheduled Tasks mode. This feature is still available for compatibility with existing Pangaea setups, but it is a fairly simple process to migrate to the new Service version. Refer to the later section on Migrating from Run Scheduled Tasks Mode.

Where to Install and Run the Task Scheduler

Pangaea consists of three elements which communicate with each other:

- The Pangaea Application, a Windows program installed on a workstation or server
- The Site Database, a SQL Server Database running on a SQL Server
- The Pangaea Windows Task Scheduler Service, installed and running on a workstation or server

It is common, especially in simpler cases, to have all three elements running on the same computer (with SQL Server Express being used as the database server). However, there are cases where there may be two or three machines involved, communicating with each other over the network or internet.

As you install and configure, it is important to understand where each element is running so that you be sure each properly.
Setting Up the Task Scheduler Windows Service

The Installation and setup of the Windows Service is done through the Pangaea application.

- You will need local Administrative privileges on the machine to install and start the Service.
- If you are going to run the Task Scheduler on a different machine than you use to create data collectors and reports in Pangaea (such as a server), you must install Pangaea on the other machine and run it from there.

Select SCHEDULER ➔ OPEN TASK SCHEDULER to open the Task Scheduler interface. If you have not yet installed or started the service, you will be prompted to open the Task Scheduler Service Settings form:

- You can also open the Task Scheduler Service Settings form by selecting SCHEDULER ➔ CONFIGURE TASK SCHEDULER.
Once open, the *Service Configuration* tab allows you to install the service, specify a login account and start and stop the service:

![Service Configuration Tab](image)

Click **INSTALL** to install the Service in Windows.

- The service will be set to run automatically when Windows boots up (Startup Type of *Automatic*). To change this behavior, you can use the Windows Service Manager.
- By default the Service is set up to run under the *Local System Account*. If this needs to be different (e.g. if you are using Windows authentication to log on to the SQL Server), click the *This Account* option and fill in the Account name and *Password*.
  - If the user is a domain user then use the standard `<Domain>\<User>` format (e.g. OURDOMAIN\JDOE) for the user name.
  - Click **APPLY LOGIN SETTINGS** to save and test your settings

Once installed, click **START** to start the service.
**Allowing Remote Access to the Task Scheduler Service**

If you want to be able to view and interact with the Task Scheduler Service that is running on this machine from a different machine, you can configure the Remote Access settings:

- **The Port** can be any number from 1 to 65535. It will be necessary for this port to be an exception setup as an exception in the Windows Firewall, as well as any others that filter incoming network traffic, to allow incoming TCP traffic.

- **The Remote Access IP Address** should be the IP address of this machine that would be visible to the remote clients (e.g., private or public, as necessary)

- **The Service Key** is used to authenticate the incoming requests.
  - If remote clients make a request with a key other than the key specified here, their requests will fail.
  - A random and unique key will automatically be generated, but you have the ability to update the key to be anything that you would like by checking the **EDIT SERVICE KEY** check box. You can also generate a new random Service Key by clicking **GENERATE KEY**. Changing the service key will disable any remote clients that are currently viewing your service, though any client that has access to the Site database can be automatically refreshed.

After filling in the remote parameters, click the **ENABLE REMOTE ACCESS** button to apply these settings. To no longer allow remote, click the **DISABLE REMOTE ACCESS**.
To connect to this service from Pangaea running on a different machine, select SCHEDULER ➔ OPEN REMOTE TASK SCHEDULER and enter the Remote Access parameters:

![Connect to Remote Task Scheduler Service](image)

### Scheduling Tasks

To set the schedule for a Data Collector or Report:

- Right-click the node in the Site tree and select SET COLLECTION SCHEDULE (or SET REPORT SCHEDULE).
- You can also set the schedule for tasks from the Task Scheduler Control Panel, as described later in this chapter.
The Edit Schedule form shows the schedule options:

- Check the SCHEDULE THIS TASK checkbox to enable the task to be run by a Task Scheduler and to enter the Schedule Settings.
- You can also choose to have the administrative results of the executed task emailed to one or more people after the task is run by checking the EMAIL TASK RESULTS checkbox. You must ensure that you have properly configured Pangaea’s SMTP and Task Scheduler settings in the TOOLS  OPTIONS form.

**Schedule Types**

There are two different types of schedules, *Interval* and *Recurrence*.

- *Interval* based schedules are generally used for running tasks more than once a day, such as data from a web sensor every 15 minutes.
- *Recurrence* based schedules are for tasks that should be run daily or less frequently, such as nightly collections or weekly or monthly reports.
For *Interval* schedules, you specify the *Interval* (in hours, minutes and seconds), which determine how often the task is run:

- The *Base Time* is used to determine the next run time when the task is scheduled, but it is *not* the first time the task will be run. If, for example, you want the task to run every hour at 15 minutes past the hour (e.g., 9:15, 10:15, etc.), you could set the Base Time to 9:15 am while leaving the interval at one hour. Pangaea will calculate the next run time based on this pattern, while still scheduling the next occurrence within the next hour. In the example above, the current time of day is between 3:15 pm and 4:15 pm, so the next scheduled date is at 4:15 pm.

- You can also choose to have the task run only on specific days and during specific times of day. In this example, the task is run only between 9 am and 5 pm on weekdays:

For *Recurrence* schedules, you specify the *Recurrence Time*, along with options for how often to run and for how long a period of time:
- For the *Recurrence Pattern*, you can choose *Daily, Weekly, Monthly* or *Yearly*, each with a number of options that should allow for almost any situation.
- The *Range of Recurrence* determines if the schedule will end automatically at a certain date or number of occurrences.

**The Task Scheduler Control Panel**

To see the tasks running and scheduled to run on the local machine’s Task Scheduler Service, select **SCHEDULER ➔ OPEN TASK SCHEDULER**:

- To edit the Service settings, you can click the **EDIT SERVICE SETTINGS** button.

  - Again this form is mostly meant for monitoring the service activity, there are some options here to help you to filter and sort the grid. First off I’ll explain the default sorting of this grid. The default sorting is used when the “Enable Custom Sorting” check box is not checked. There are several factors involved in the sorting, and I’ll list them in the order of precedence below:
    - First off any task that is currently running will always be sorted to the top.
    - After that the tasks will be sorted by “Next Run Time”, so the closer to the front of the execution queue that they are the closer to the top of the grid that they are.
    - Finally any schedulable nodes that are not currently running in the scheduler will be sorted to the bottom, and
with be listed alphabetically by node name underneath the currently running tasks. (These items will not always be displayed in the Task scheduler UI, the conditions under which they will be displayed are discussed later)

- If you need to look at the data with a sorting other than the default then you have the ability to do that as well. To do this click on the “Enable Custom Sorting” checkbox. The initial state of the custom sorting is sorted by Task Name Ascending. To change this you can click on the column heading of the column by which you would like to sort the data. All columns are initially sorted in ascending order, but can be reversed and be sorted in descending order instead. To do this click on the column header a second time. This will reverse the order in which the column is sorted.
- Another option is the site filter. The Pangaea task Scheduler can run the tasks for multiple sites on the same machine. Setting Pangaea sites to run in a particular task scheduler instance will be discussed in a later section. The site filter will contain a list of site names for sites which are running in the monitored task scheduler instance. There will also be an “All” option which will display all sites running in the monitored task scheduler. Selecting any site in the filter that is not “All” will force tasks belonging to all other sites to drop out of the list view.

  - Schedulable Nodes:
    - There is another check box on the Task Control Panel that hasn’t been talked about yet. This check box is labeled “Show Scheduled Nodes From Open Sites”. If this check box is checked then any nodes that can be scheduled, and either aren’t, or are in sites that are not being monitored, but are in sites on that are which the tasks run in a different instance of the task scheduler. You can do a couple of things with these items.
      - First you can update their task information to add them to the schedule or to change their scheduling parameters. If you enable scheduling for an item in a site that is being monitored it will be moved from the schedulable nodes section to the currently running tasks section after being picked up by the task scheduler.
      - Secondly you can Edit the actual node properties from here too if you need to. Both of these options are available from the context menu which will be discussed momentarily.

  - List View Context Menu:
There are a few items that may be displayed when right clicking on a task in the list view depending on what state Pangaea is in, and what Task Scheduler instance is being monitored.

If the Task is currently running in the instance of the task scheduler that is being monitored and the site which the task belongs to is open in the Pangaea site tree then you will get a context menu as follows:

- **Start Task** will send a command to the Task Scheduler instance instructing it to start running the selected task immediately regardless of its next scheduled time. Note: the task scheduler will never allow the same to run more than once at the same time, so if this forces the running of the task to overlap with its next scheduled run time then this will count as that run, and the task will then be rescheduled to run at its next scheduled interval. If, however, the task does stop running before its next scheduled time then the scheduling will again pick up at its next scheduled time.

- **Edit Node Schedule** will allow you to update the Task’s schedule. Updating a task’s schedule may not be picked up instantaneously by the Task Scheduler, but the scheduler does synchronize quite often, so it shouldn’t take too long before the scheduler updates to reflect the changes that you have made.

- **Edit Node** This will open up the property editor for specific to the node type being edited and allow you to make changes to that node. The node scheduler does check for changes to the node before running any tasks, so as long as you save the node before the task runs then these changes are guaranteed to be applied when the task is next run.
The bottom section of the control panel just shows some statistics for the currently monitored Task Scheduler Service. These are for informational purposes only, and cannot be interacted with. Site filters do not apply to this data.

- **Sites**

Each Pangaea site is allowed to run in one, and only one Task scheduler instance. Which instance that is, is dependent on the machine name that is assigned to the site. A new tab has been added to the Site properties form which lets you specify what machine owns the site for task scheduling. There are three options which are self-explanatory:

![Site Properties Form](image)

- **Remote Access**

  - To remotely access the task scheduler for a particular site click the “View Task Scheduler…” context menu item. There are a couple of things to note about this. First the context menu will only show up if the Task Scheduler is actually running. Second if the site is assigned to this machine then the task scheduler control panel will be opened in local mode instead of remote mode. The only differences between local and
remote mode is that in remote mode, you will not have access to the service settings, and the site filter will be locked down to the site that you are viewing.

One more note about remote node is that there is another way to access it. This other way requires that you know all of the connection credentials for the remote scheduler; also I do not think that this will be the permanent UI for accessing the task scheduler this way. When you do access it this way the site filter lock restriction that is applied in the above mentioned method does not apply. To get to this alternate method of remote access go to the main Pangaea menu and select Tools → View Remote Task Scheduler…. You will be prompted with this dialog, enter the values and click ok.
13. Dashboards

Another feature Pangaea offers is Energy Dashboards, which provide active real-time data display, as well as dynamic displays of complex data sets. Creating and editing dashboards is as simple as clicking, dragging, and resizing widgets in your web browser and setting the more specific properties in Pangaea.

Energy Dashboards gather information from various instruments and systems so that energy consumption can be tracked against dynamic energy targets. This enables specific goals for improving energy use and emissions reduction objectives to be established. With rising energy costs and increasingly tight environmental regulations expected over the long term, users require greater visibility into their energy usage and a comprehensive strategy to reduce associated costs. In addition, the Energy Dashboard ensures that energy management flows from planning and business functions through to operations and provides the associated feedback.

Creating a new Web Dashboard

To create a new Dashboard, right click on an open site or folder in the main window and select ADD → DASHBOARD.
When you open a new Dashboard, the dialog will look like the one shown below:

**User Interface**

Pangaea dashboards have a unique user interface for editing and updating your Dashboards and widgets easily and in real-time.
**Widget List**

The Widget list on the left side of the form contains all of the Widgets in the current Dashboard. The ‘Duplicate’ Button below the list box can be used to duplicate the selected Widget in the list and retain most of its properties. Widgets can also be duplicated when editing in the browser by right-clicking on a Widget and selecting ‘Duplicate’ in the context menu.

![Dashboard Widgets](image)

**Property Grid**

The property grid on the right side of the screen contains a list of all of the properties for the selected widget in the list. This is where most of Widget customization takes place. The first item in the Widget list is actually a list of editable properties for the Dashboard itself. These properties include things such as Dashboard size and editing options. When you select a property in the property grid, there will also be a description of that property and its use at the bottom of the property grid for further clarification.

![Widget Properties](image)
**Widgets**

A Widget is a graphical object that can be customized and added to your Dashboard. Certain Widget types can be attached to existing Points in Pangaea and can display their data values. The list of available Widgets Pangaea offers can be seen below:

- Bar Graph
- Clock
- Corner Gauge
- Fuel Gauge
- Gauge
- IFrame
- Image
- Label
- LED Alert
- Lightbulb
- Line Graph
- Marquee
- Meter
- Odometer
- Panel
- Pie Graph
- Progress Bar
- Thermometer
- Weather
Adding Widgets

To add a new Widget to your dashboard, select the type of Widget you wish to add in the combo box and click the ‘Add’ button.

![Add Widget](image)

The new Widget will then be selected in the Widget list and its properties will be shown in the property grid.

![Dashboard](image)
**Editing Widget Properties**

To edit a Widget property, select a property in the grid and click on its value to the right of the property name. From here you can edit the property value.

![Editing Widget Properties](image)

**Connecting Widgets to Point Values**

Some Widgets have the ability to visually display one or more values which can be provided by points in Pangaea. The Widgets which support point values are:

- Bar Graph
- Corner Gauge
- Fuel Gauge
- Gauge
- Label
- Light Bulb
- Line Graph
- Marquee
- Meter
- Odometer
- Pie Graph
- Progress Bar
- Thermometer
**Selecting a Point**

To Connect a Widget to a Point, select your Widget and click on the Point ID property in the property grid. When highlighted, the Point ID property will show a small button with three dots on the far right.

To specify a Point, click the button and the dialog below will appear:

![Select Point Dialog]

**Value Source**

When connecting a Widget to a Point, you can choose whether the Widget should request Live or Logged Point Values. The default data source is always logged. The Live data source is only available for points whose Data Collector supports live value requests and
the data source option will not be shown unless both data sources are supported. If the ‘Logged’ data source is chosen, the Widget will use the last value that was logged for the specified point in the database. If the ‘Live’ data source is chosen, the widget will attempt to collect a real-time value for the specified point from that point’s Data Collector.

**Data Request Frequency**
The Data Request Frequency property specifies how many seconds an individual widget should wait to update its Value between requests.

**Editing the Dashboard in the Web Browser**
Editing your dashboard in a web browser allows you to drag, resize, duplicate, delete and layer your widgets. Modifying specific properties like color or font are done in the property grid in Pangaea. When you mouse-over, click, drag or resize a widget in your web browser, Pangaea will automatically update the selected widget and its properties in the application.
To begin editing your Dashboard, click the ‘Start Editing’ button. This will automatically open your Dashboard in Internet Explorer. When you mouse over Widgets in the web browser, a yellow border will appear around them until the mouse cursor leaves them. You can select a Widget in the web browser simply by clicking on it. This will display a red border around the selected Widget and automatically select that Widget in Pangaea in the Dashboard Widget list. The red border will remain around the selected Widget in the web browser until another Widget is selected. If you select a Widget in the Dashboard Widget list, it will also select the correlating Widget in the web browser.

**Context Menu**

When you right click on a Widget in your web browser, a context menu will appear. This menu has a list of possible actions you can take on that Widget which include Duplicate, Delete, and Send to Back/Bring to Front. “The Send to Back” and “Bring to Front” buttons change the layering of a Widget, whether it is in front of or behind other Widgets within the Dashboard.
Layering
The “Send to Back” and “Bring to Front” buttons change the layering of a Widget, whether it is in front of or behind other Widgets within the Dashboard.

To place Widgets in front of or behind other Widgets, right click on the Widget you wish to move and click either ‘Bring to Front’ or ‘Send to Back’. The desired result will be achieved as shown below:
**Dashboard Options**

The first item in the Widget list is always the ‘Dashboard Options’ item, which contains a list of properties for the Dashboard itself, as well as user interface properties such as browser editing options.

**Main Options**

The main Dashboard options include properties such as Dashboard size and background color or image.

**Background Image**

To set a background image for your dashboard, select the ‘Dashboard Options’ item in the Widget list and click on the ‘Background Image Properties’ item in the property grid. A small button with three dots will appear on the far right side of the property. Click the button and the prompt below will appear.
Next you will need to import an image to use as your background. Click the ‘Import Image’ button in the top right corner of the form to continue.

This dialog allows you to specify an image to use either from a web URL or an image file on your local computer or network. After you have selected the image to import and provided a name for it click the ‘Import’ button. After importing an image, it will automatically be added and saved to a list of imported images which will be available for you to use on any of your dashboards within the site. There are a few additional properties you can apply to an image once you have imported it such as setting the size mode and image transparency. The preview box on the left side of the dialog will display a sample of what the image will look like when applied.

**Editing Options**

The Dashboard editing options allow you to specify your preferences when editing Dashboard Widgets in the web browser such as snapping Widgets to a grid when being dragged or allowing Widgets to be moved outside the bounds of the Dashboard.
Dashboard Templates

A Template is simply a saved version of a Dashboard that can be modified and applied to other Dashboards. To create or edit Dashboard Templates, click the ‘Dashboard Templates’ menu item in the top toolbar and click ‘Edit/Select Dashboard Templates’.

When you open the Dashboard Templates, the dialog below will appear.
Creating a new Template
To create a new Dashboard Template from the current Dashboard, begin typing a name for it in the Name textbox. Once you have given it a name, click the ‘Create New’ button on the left side of the textbox. This will create a saved version of the current Dashboard that can then be applied to other Dashboards.

Previewing Templates
To preview a template in the web browser, select it in the Templates list and click the ‘Preview’ button. This feature allows you to view your saved Templates before you apply, modify or delete them.

Overwriting Templates
Overwriting a Dashboard Template will create a new Template from the current dashboard and replace the Template selected in the list.

Applying a Template
To apply a Dashboard Template to a new or existing Dashboard, open the Dashboard and open the Dashboard Templates dialog. From here you can specify which saved Dashboard Template you wish to apply to the current Dashboard. If you are unsure which Template is which or what they look like you can always select a Template from the list and click the ‘Preview’ button to view it in your web browser.
To apply an existing Dashboard Template to your current Dashboard, select the Template you wish to apply from the list and click ‘Apply Template’. A prompt will appear warning you that the current Dashboard will be overwritten. If you wish to continue click ‘Yes’ and the selected Dashboard Template will be applied to your current Dashboard.

Dashboard Publishing

Publishing a Dashboard means to make it viewable from the Smartware website. When you publish a Dashboard, Pangaea will send information about your Dashboard to the Smartware servers. When someone views the Dashboard in a web browser, our servers will contact your Pangaea database to retrieve the necessary Dashboard information and will build and display the web page.

Connection Information

To publish a Dashboard, the Pangaea Site (SQL Database) that the dashboard belongs to must be accessible from the internet. This is necessary because when someone navigates to your published Dashboard pages, the Smartware servers will contact your SQL database to get the information it needs in order to build and display the Dashboard page. If you are unsure if your SQL server is accessible externally or need help configuring it for access contact your I.T Department.

Dashboard Slots

A Dashboard slot is simply reserved space on the Smartware website used for hosting Dashboards. Before you can publish a Dashboard in Pangaea, you will need to purchase one or more Dashboard Slots from Smartware. Each Dashboard Slot is assigned its own ‘Published ID’ and unique web URL, which you will use when publishing and viewing your Dashboard.
**Publishing a Dashboard**

To publish one of your Dashboards, right click on the Dashboard you wish to publish from the main Pangaea form and select ‘Publish…’

![Publish Dialog](image)

After clicking the ‘Publish…’ button, the dialog below will appear.
Next you will need to select a Dashboard Slot to publish your Dashboard to. To do this, click the ‘Select’ button. The dialog below will appear displaying all of the Dashboard Slots you have purchased.

Select the Dashboard Slot you wish to publish this Dashboard to, and click the ‘Select’ button at the bottom right corner of the dialog.

**Dashboard Login Information**

After you have chosen a Dashboard Slot to publish to, you will need to configure the Dashboard login information. If specified, the Dashboard login credentials will be required for everyone who visits your Dashboard in a web browser. You can specify whether your Dashboard page will require a login or not by checking or unchecking the ‘Require Login’ checkbox. After you have filled out the necessary information on the
form, click the ‘Publish’ button at the bottom right corner of the form to publish your Dashboard. If there is already a Dashboard occupying the Dashboard Slot you have selected, a prompt will appear asking if you wish to replace the published Dashboard in that slot with this Dashboard.

![Publishing this dashboard will overwrite the dashboard that is already published in that slot. Are you sure that you would like to overwrite this dashboard now?](image)

**Pricing**
Visit our website at smartwaretech.com to for pricing details and other information.

**Notes**

**Editing**
If you are editing a Dashboard and trying to view the Published version on the Smartware website, you may notice that some of your changes are not immediately visible on the published site in your browser. This may happen because when you log into the Dashboards site to view your Dashboard, the site saves some of the Dashboard content locally in your web browser. To resolve this, you will have to clear the session information in your web browser.

**Widget Point Values**
If your dashboard employs Widgets that use Live values as their data source, the device or machine that the Point’s Data Collector uses to get its value must have an accessible external IP for Pangaea to be able to get the Live Value. IP addresses such as 192.68.0.10 are internal network addresses and therefore are inaccessible from the Pangaea website.
Widget Library

Images
- Background Images
- Animated GIFs
- Status Images
  - Boolean: e.g. Fan On, Fan Off
  - Multistate: e.g. Damper Closed, Open 50%, Open 100%

Marquees
- Single line of text that scrolls upward
- Upward scrolling HTML Announcements

Text
- All fonts, colors, styles
- Show any value with engineering units
- Show averages, minimums and maximums without extra BMS logic

Panels
- Groups other widgets together

Gauges
- Radial, Fuel-style, Thermometer, Progress, Odometer

Video
- Requires extra hardware, software, network configuration

Weather Applet
- Current Local Conditions and Forecast

More to Come
- Carbon Savings Display (energy converted to barrels of oil, trees, cars, etc.)
- Multi-value widgets: Bar graphs and charts
<table>
<thead>
<tr>
<th>Text Labels (all Fonts and Colors)</th>
<th>Panel</th>
<th>Thermometer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dashboard label</strong></td>
<td><img src="image" alt="Panel" /></td>
<td><img src="image" alt="Thermometer" /></td>
</tr>
<tr>
<td><strong>SMARTWARE</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Progress Bar</th>
<th>Gauge</th>
<th>Odometer</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Progress Bar" /></td>
<td><img src="image" alt="Gauge" /></td>
<td><img src="image" alt="Odometer" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Fuel Gauge</th>
<th>Lightbulb</th>
<th>Fuel Gauge</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Fuel Gauge" /></td>
<td><img src="image" alt="Lightbulb" /></td>
<td><img src="image" alt="Fuel Gauge" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Current Date and Time</th>
<th>Weather Forecast</th>
<th>LED Alert</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>12:06 PM</strong>&lt;br&gt;<strong>MONDAY, 06/03/2013</strong></td>
<td><img src="image" alt="Weather Forecast" /></td>
<td><img src="image" alt="LED Alert" /></td>
</tr>
</tbody>
</table>
Sample Dashboards

![Image of Sample Dashboards]

Smartware Pangaea
14. StoryBoards

The StoryBoard object allows you to create a dynamic playlist of dashboards that automatically transition from one to another at specific intervals.

**Creating a New StoryBoard**

To create a new Dashboard, right click on an open site or folder in the main window and select **ADD → STORYBOARD**.

When you open your new Storyboard, the dialog below will appear:
**Adding Dashboards**

To add a new Dashboard to your StoryBoard, select a Dashboard from the Dashboard combo box at the top of the screen and click the ‘Add Dashboard’ button.

After adding a new Dashboard, it will appear in the Dashboard Pages list box and the settings for the currently selected dashboard will appear in the region at the bottom. To preview any of the Dashboards you have added in a web browser, select the Dashboard you wish to view from the list and click the ‘Preview Dashboard’ button below the list box.
**Storyboard Transitions**

Storyboard Transitions are the actions to take after each Dashboards display duration has elapsed. The Transition specifies the next Dashboard page to redirect to.

**Conditions**

For each Dashboard in a StoryBoard, you have the ability to add one or more conditions. Conditions are basically actions to be taken based on the value of a Point while a Dashboard is being displayed. Conditions can be true or false values based on the value of a Point from a given Data Collector. The user can specify what value will satisfy the condition, whether the value to be used is live or logged data, and the Dashboard to redirect to if this condition is met. Conditions can be enabled or disabled by checking or unchecking the ‘Enable Dashboard Transitions’ checkbox. This allows you to employ or ignore previously added Dashboard Conditions without having to delete or re-add them.

**Adding a Condition**

To add a new Dashboard Condition, select the Dashboard in the list and click the ‘Add Condition...’ button at the bottom left corner of the dialog. This will bring up a new dialog where you can specify the Point and properties for the new Condition.
To continue adding a new Condition, select a Data Collector from the Data Collector combo box and navigate the tree view below it to find the Point value you wish to use for the Condition. Next, select the value (True or False) which will be used to determine whether the Condition is met. Finally, Select a Dashboard page from the ‘Go to Page’ combo box to state which Dashboard page to transition to if the given condition is met.

Once your new Condition is added, it will become active during the current Dashboard page’s display and will be triggered if the Condition is satisfied.

**Publishing**
Publishing a Storyboard uses the same process as publishing a Dashboard. For instructions, see the ‘Dashboard Publishing’ section in the Dashboards chapter.
15. Configuring Pangaea for Sending Email